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FROM THE AUTHOR 
Welcome to How to Rank and Value Fantasy Baseball Players for Points Leagues. 

I’m probably very much like you.  I consider myself an above average fantasy 
baseball player.  I play in a handful of leagues, each one a little different with its 
own twists and intricacies.   

And that’s what has always made me uncomfortable with following and reading 
the mainstream fantasy advice that is readily available.  Even if we assume that I 
can wade through and separate the good fantasy analysts from the bad, there’s no 
way even the best analyst’s rankings will take my league intricacies into account. 

The only way to get an edge on your league is to create  
your own rankings. 

I believe that if you truly want to be a great fantasy baseball player you need to 
calculate your own rankings and dollar values that are tailored for your specific 
league.  “If you want something done right, do it yourself”. 

These instructions are intended to teach you a method you can use to create your 
own rankings.  I’m not here to tell you if Bryce Harper is going to hit 15 HR next 
year or 35.  But I will tell you how those HRs should be valued in your league. 

If you have any suggestions for improvements to this book, please e-mail me at 
SmartFantasyBaseball@gmail.com or use the comment message boards that 
correspond to each chapter in the book. 

Thank you for your purchase and for supporting SFBB. 

   

      ~ Tanner Bell   

mailto:SmartFantasyBaseball@gmail.com
https://twitter.com/smartfantasybb
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OBJECTIVES 
When you complete this guide, you will have an Excel file that will allow you to: 

• View projections for any fantasy-relevant player 
• View a complete ranked list of all players at any position 
• View the dollar value of each player, based upon your specific league settings 
• View an inflation-adjusted dollar value for each player based upon keepers 

and/or actual in-draft results 
• Update projections for any player and immediately see a revised ranking and 

dollar value for the player 

OVERVIEW 
These instructions demonstrate the process of creating rankings and dollar values 
for a 12-team points league with the following scoring format: 

Hitter Points Pitcher Points 
AB -1 IP 6 
H 5 K 2 
BB 3 BB -2 
2B 3 HA -3 
3B 5 SV 5 
HR 9 HD 4 
SB 3 HRA -12 

 

I know what you’re thinking.  “That’s a really weird scoring format, there’s no way 
this book is for me”.  

Well, I chose this on purpose.  To me, points leagues are like fingerprints and 
snowflakes.  Each one is a little different than all the others.  So for me to pick a 
“standard” points league to illustrate this process seems like a fool’s errand. 

My intent for this book is to help you develop the skills and methodologies 
necessary to create customized rankings and dollar values for ANY kind of points 
league.   
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Your league’s scoring format is surely different than the example I will use in this 
book.  I will lay out example formulas for the settings above, you’ll just need to 
tweak the formulas slightly to tailor things for your league’s settings.  In the end, 
you will have rankings and dollar values tailored specifically to you league. 

WHY I WROTE THIS BOOK 
I've spent hours, maybe days, of my life scouring the web looking for guidance on 
how to calculate my own rankings. It seems like nobody takes the time to explain 
exactly how to do these things. If you look hard enough you might find an article 
that gives a quick bullet point list.  Maybe something like: 

• Download projections 
• Multiply projections by your point system 
• Adjust for replacement level 
• You're done! 

This book is pushing 25,000 words.  So they’re leaving some details out!   

My goal is for this to be the most comprehensive guide on creating customized 
points league rankings you can find ANYWHERE. 

MICROSOFT EXCEL 
These instructions have been written for Microsoft Excel for Microsoft Windows.  
I used Excel 2013 while creating this guide and taking screenshots, but you 
should have no issue if you’re using Excel 2010 or Excel 2007 for Windows. 

Unless you’re a highly skilled spreadsheet user, this guide is likely not for you if 
you have Excel for Mac or are using a different spreadsheet program.  
Unfortunately Microsoft creates very different versions of Excel for Mac and 
Excel for Windows.   

DOWNLOAD EXAMPLE EXCEL FILES 
Visit this page at SmartFantasyBaseball.com to download the example Excel files 
that accompany this book.  The files for each part represent what your 
spreadsheet should look like at the end of that given chapter.  For example, if 
you’re having difficulty on “Part 7”, you can download the completed Excel file for 
that section and see the formulas as they are intended to be used in an actual file. 

http://www.smartfantasybaseball.com/how-to-rank-and-value-players-in-a-points-league-example-excel-files/
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THE HISTORY OF THIS BOOK 
This book began as a series of free blog posts originally written and posted at 
SmartFantasyBaseball.com.  The six part “How to Calculate Custom Rankings for 
a Points League” series corresponds to Parts 1 through 6 of this book.  This book 
picks up on the great void in the free portion of the series – how to convert 
projected points for players into dollar values. 

There are links to the original series throughout this book because I want to have 
an avenue for people to ask questions and have some discussion about the series.  
If you find yourself stuck on a particular part of the instructions, visit the 
comments section for that particular part.  See if others have experienced the 
same issue or ask a question in the comment area. 

The projections used in this book are the Steamer 2015 preseason projections 
from Fangraphs.  If you see projections that you disagree with or that appear 
unusual, it's likely because I began writing this book in December 2014, still early 
in the off-season. 

IF YOU HAVE QUESTIONS 
Please post your questions or comments about the process in the comment 
section for the most applicable part in the book.  You can use the links below to 
jump right to the comment areas for each part: 

• Part 1 – Download Projection Data and Player ID Map 
• Part 2 – Set Up League Scoring Settings 
• Part 3 – VLOOKUP, Excel Tables, and Structured References 
• Part 4 – Pitcher Rankings 
• Part 5 – Calculating Projected Points 
• Part 6 – Replacement Level and Position Scarcity 
• Part 7 – Dollar Value Calculation Settings 
• Part 8 – Converting Points into Dollar Values 
• Part 9 – Incorporating In-Draft and Keeper League Inflation 

http://www.smartfantasybaseball.com/
http://www.smartfantasybaseball.com/2015/01/how-to-calculate-rankings-for-a-points-league-part-1-download-projection-data-and-player-id-map/%23comment-970
http://www.smartfantasybaseball.com/2015/01/how-to-calculate-rankings-for-a-points-league-part-2-league-scoring-settings/%23comment-971
http://www.smartfantasybaseball.com/2015/01/how-to-calculate-rankings-for-a-points-league-part-3-vlookup-excel-tables-and-structured-references/%23comment-972
http://www.smartfantasybaseball.com/2015/01/how-to-calculate-rankings-for-a-points-league-part-4-pitcher-rankings/%23comment-949
http://www.smartfantasybaseball.com/2015/01/how-to-calculate-rankings-for-a-points-league-part-5-calculating-projected-points/%23comment-973
http://www.smartfantasybaseball.com/2015/02/how-to-calculate-rankings-for-a-points-league-part-6-replacement-level-and-position-scarcity/%23comment-974
http://www.smartfantasybaseball.com/how-to-rank-and-value-players-in-a-points-league-part-7/%23comment-978
http://www.smartfantasybaseball.com/how-to-rank-and-value-players-in-a-points-league-part-8/%23comment-977
http://www.smartfantasybaseball.com/how-to-rank-and-value-players-in-a-points-league-part-9/%23comment-976
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The comment areas for Parts 7 through Part 9 are not readily available on the 
web (they won’t show up in Google and you can’t get to them navigating around 
the website).  The only way to get to those comment areas is to use the links 
within this book.  They are just for readers of this book.   

PART 1 – DOWNLOAD PROJECTION DATA AND 
PLAYER ID MAP 

INTRODUCTION 

In this first part of the book we'll download hitter and pitcher projections, take 
a look at and download player ID information, and bring all of this 
information into one Excel file. 

WHERE TO GET PROJECTIONS 

There are many solid projection systems available for download.  Some very 
fine projections are available at membership sites like Baseball Prospectus or 
Baseball HQ. 

But if you're like me, when I started out on the adventure of calculating my 
own rankings, I wasn't looking to pay for something I wasn't sure I'd be able to 
translate into fantasy success.  It's great to have accurate projections, but how 
do you use them if you can't take the next step to rank and value those 
projections? 

For that reason, I'm partial to the Steamer projections.   

They're available in easy-to-use Excel downloads (specifically CSV) at 
Fangraphs. There are also daily rest-of-season updates, meaning on any day 
you can see the projections for the remainder of the season for any 
player.  Steamer also does a good job of projecting playing time (if a player 
gets hurt, they try to estimate the effect on playing time). 

And they're free. 

USE WHATEVER PROJECTION SYSTEM YOU PREFER 

I'll be using Steamer in this example.  But you can use the system of your 
choice.  Just try to pick a system that uses some form of player ID system. 

http://steamerprojections.com/blog/about/
http://www.fangraphs.com/projections.aspx?pos=all&stats=bat&type=steamer
http://www.fangraphs.com/projections.aspx?pos=all&stats=bat&type=steamer
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If you’re looking for your next adventure after this book, you can try creating 
your own projections. 

WHAT IS A PLAYER ID? 

Just like you and I are identified by Social Security Numbers or employee IDs 
(at work), most of your major fantasy or MLB websites use a form of ID 
number that is unique to each player. 

Using an ID is a more reliable way of identifying a player than a simple 
name.  Two players can have the exact same name (think Chris Youngs and 
Alex Gonzalezes) which could cause confusion when ranking players. 

And players can go by different name variations (Mike and Michael, Jon and 
Jonathan, JP and J.P., AJ and A.J.) or even change their name (Mike to 
Giancarlo Stanton, Fausto Carmona to Roberto Hernandez). 

Here's a quick look at some player IDs for various systems: 

Player ID Source Mike 
Trout 

Clayton 
Kershaw 

Giancarlo 
Stanton 

Baseball Reference troutmi01 kershcl01 stantmi03 
Fangraphs 10155 2036 4949 
MLB 545361 477132 519317 
CBS 1739608 1221725 1630093 
ESPN 30836 28963 30583 

 

If you're wondering how to determine someone's player ID, the trick I use is to 
visit their player page on a particular website.  You can usually find the player 
ID in that web page's URL.  For example, here's Mike Trout's MLB.com player 
page and his player ID is highlighted in the image: 

 

In looking at that table above, you can see here that there is not one universal 
numbering system. 

http://www.smartfantasybaseball.com/projecting-x-podhorzer-how-to-create-your-own-fantasy-baseball-projections/
http://www.smartfantasybaseball.com/projecting-x-podhorzer-how-to-create-your-own-fantasy-baseball-projections/
http://losangeles.angels.mlb.com/team/player.jsp?player_id=545361
http://losangeles.angels.mlb.com/team/player.jsp?player_id=545361
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To alleviate this problem of tracking hundreds of IDs and various systems, I 
maintain a "Player ID Map" (click here to download in Excel).  The Player ID 
Map lists out all "fantasy-relevant" players and their ID for each of the major 
systems (Fangraphs, Baseball Reference, Baseball Prospectus, Yahoo, ESPN, 
etc.). 

 

I stumbled across the concept of the player map at Tim 
Blaker’s website Crunchtimebaseball.com and I then tailored it to meet my 
needs.  Tim maintains his own version and updates his more frequently than I 
do.  I only maintain my own because I've wanted to add some new columns. 

On this site I will typically work with the Baseball Reference ID as my main 
system.  I like those IDs more than the others because I can look at an ID and 
usually determine who the player is (troutmi01 is Mike Trout).  Most other 
sites use a straight ID number that has no inherent meaning (10155 or 
545361). 

If you're familiar with Excel and using VLOOKUPs, Player IDs are the item 
we'll be matching upon to start pulling information around our Excel rankings 
file.  If you have no idea what I just said, don't worry.  We'll get there soon. 

Let’s get started building our Excel file! 

STEP-BY-STEP INSTRUCTIONS 

Step Description 
1. Open Excel and save a blank new file to hold our points league rankings. 

http://www.smartfantasybaseball.com/wp-content/uploads/2013/03/SFBB-Player-ID-Map.xlsx
https://twitter.com/crunchtimebb
https://twitter.com/crunchtimebb
http://crunchtimebaseball.com/baseball_map.html
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Step Description 

 
2. Download the pitching and hitting projections of your choice.  For this 

example I will be using the Steamer projections available at Fangraphs.  

 
Be sure to download both the hitter and pitcher projections. 

To download the data from Fangraphs, click the "Export Data" link on the web 
page. 

 
This will download a CSV file to your computer. 

3. Locate the downloaded hitter and pitcher projections on your computer. 

 
As you download more and more reports from Fangraphs they will be 
sequentially numbered (1), (2), etc. 

Open the hitters file in Microsoft Excel first. Right click on the tab and select 
the option to "Move or Copy...". 

http://www.fangraphs.com/projections.aspx?pos=all&stats=bat&type=steamer&team=0&players=0
http://www.fangraphs.com/projections.aspx?pos=all&stats=bat&type=steamer&team=0&players=0
http://www.fangraphs.com/projections.aspx?pos=all&stats=pit&type=steamer&team=0&players=0
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Step Description 

 
At the next menu, click the drop down menu. Choose to move the projections 
to your rankings Excel file (created above) by selecting the rankings file from 
the drop down list.  Then hit "OK". 

 
Repeat this step for the pitcher projections. 

4. Right-click on your hitter and pitcher projection tabs and choose the 
"Rename" option. 
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Step Description 

 
It will be important to name your spreadsheet tabs with meaningful names so 
you can easily keep track of what each of the spreadsheet represents. 

I will name my tabs "Steamer Hitters" and "Steamer Pitchers". 

 
5. Download and open the SFBB Player ID Map (click that link and it should 

begin to download).  Right-click on the "PLAYERIDMAP" tab. 

 
In the “Move or Copy” menu, select your rankings spreadsheet in the “To 
book:” drop down menu (we’re copying the Player ID Map into the Rankings 
file). 

http://www.smartfantasybaseball.com/wp-content/uploads/2013/03/SFBB-Player-ID-Map.xlsx
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Step Description 

 
Choose to move the PLAYERIDMAP to the end of the rankings file and click 
"OK". 

6. You’re going to be looking at this spreadsheet for a significant amount of time, 
so you should spend a minute on the aesthetics.  

Right click on the tabs and choose the option to add some color to this thing 
(“Tab Color”). 
 

 
If you’re interested, Smart Fantasy Baseball Blue is custom color 17R, 137G, 
183B on the RGB scale. 

 
7. We're done. Save the file. 
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WRAP UP 

At this point we have downloaded some powerful hitter and pitcher 
projections and incorporated a listing of player IDs.  In the next part of this 
book we'll create a “Settings” tab where we will document the scoring settings 
for your league. 

DO YOU HAVE ANY QUESTIONS? 

Do you have questions about Part 1?  Or want to see what others have asked?  
Check here. 

EXAMPLE EXCEL FILE 

Download the example spreadsheet illustrating the work done in this part 
here.  Or you can download all spreadsheets for the entire book here.  

PART 2 – SET UP LEAGUE SCORING SETTINGS 
INTRODUCTION 

In this second part of the book, we'll create a new tab in our Excel file 
to document our league's scoring settings.  We'll use Excel's "Name" feature so 
we can calculate projected points for all players and easily make changes to the 
scoring system in the future. 

EXCEL FUNCTIONS AND FORMULAS IN THIS PART 

Below are the Excel functions and formulas used in this part of the book.  If 
you're already familiar with what these are, you can skip ahead. 

NAMED CELLS (OR NAMED RANGES) 

Excel has a feature called "Names", where you can give a cell, a group of 
cells, or an entire table, a name.  After giving a cell a name, you can then 
use the name in calculations. 

In this part of the book we'll give names to the point values of each scoring 
category for our league. Let's assume each HR for a hitter is worth 9 points. 

http://www.smartfantasybaseball.com/2015/01/how-to-calculate-rankings-for-a-points-league-part-1-download-projection-data-and-player-id-map/%23comment-970
http://www.smartfantasybaseball.com/points1
http://www.smartfantasybaseball.com/jzv0
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We can name this point value as "H_PTS_HR". 

If we're later trying to determine how many points Javier Baez will earn 
from home runs, we can multiply Baez's projected home runs by 
"H_PTS_HR" instead of multiplying by 9 or by cell B7 (in the image 
above). 

 

If you're familiar with the basic concepts of computer programming, setting 
the point value of home runs equal to a name is like using a variable. 

The benefit of this is that we can later change the 9 to a different value. This 
is especially useful if we play in multiple leagues or if the scoring format 
changes. 

It becomes very easy to change the scoring system without having to search 
within complex formulas. And we also don't need to flip back and forth and 
remember that the HR point value was in B7 (as opposed to B6 or B8). 

Using a name also gives the formula "meaning".  It's a lot easier to 
understand this: 

= B2 * H_PTS_HR 

Than it is to understand this: 

= B2 * B7 
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Another helpful benefit is that Excel makes all of your Names available 
through a type-ahead feature.  So if you know you have a series of Names 
that start with "H_PTS_", you can see all of them by typing out part of the 
name. This works no matter what tab of the Excel file you are on, meaning 
you don't have to flip back and forth to figure out the exact cell holding the 
point value. 

 

USING CELL SHADING TO INDICATE MEANING 

As we continue to build a spreadsheet that will eventually be quite complex, 
it can be helpful to indicate which cells are "input" cells and which ones are 
"calculated" (formula) cells. An easy way to denote this is by using cell 
shading (or coloring). 

An "input" cell would be facts or assumptions that will later be used in 
formulas for calculating projected points and player rankings.  For 
example, the number of points for each home run hit or the number of 
teams in the league. 

A "calculated" cell will obviously be some kind of formula we enter in Excel. 

The color coding will help remind you what cells you can change in the 
future (inputs) and what cells you should leave alone (formulas, 
calculations). 

You can use your own color scheme, but for the rest of the series I will 
shade cells blue if they are "input" cells and a light red if they are 
"calculated" cells. 
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Besides the meaning behind the color coding, this also offers a nice 
intimidation factor to your opponents at the draft table.  Who knows, 
someone might just think twice about getting in a bidding war with you if 
you've got a powerful looking spreadsheet on-screen. 

ADJUST FOR YOUR LEAGUE’S SCORING SETTINGS  

As I mentioned earlier, the example league I'm using to create these rankings 
is a bit unique.  The league is loosely based on a scoring system suggested 
for Fangraphs Ottoneu leagues.  It is likely very different than the scoring 
system in your league.  Accordingly, you will need to use judgment and tailor 
the steps below to fit your league's specific scoring system. 

http://www.fangraphs.com/fantasy/how-hitting-is-scored-in-ottoneu-fangraphs-points-leagues/
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STEP-BY-STEP INSTRUCTIONS 

Step Description 
1. Add a new sheet to your Excel file. 

The method of doing this will vary depending on the version of Excel you are 
using, but a keyboard shortcut to add a new sheet is SHIFT + F11 at the same 
time. 

  

2. Right-click on the blank sheet and choose the option to "Rename".  

  

Name this sheet "Scoring Settings". 

3. Visit your league's website.  Find the settings page and locate the list of point 
values for each stat category. 
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Step Description 

 
On your "Scoring Settings" sheet, create a list of the various scoring categories 
and the point value for each. 

 
4. In order to apply the concept of shading cells discussed above, I first place a 

border around the cells to point value cells. 

In my example file, I want to format cell B2. To do this click once on cell B2 
and select the "Borders" drop down menu on the Ribbon.  Then choose the 
"Outside Borders" option. 
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Step Description 

 
5. Cell B2 will be an input cell that should be shaded blue.  So while you still have 

B2 selected, click the "Fill Color" drop down arrow (the paint can icon) and 
click on the desired shade. 

 
6. To quickly format the other input cells, while still selected on cell B2, double-

click the "Format Painter" icon (looks like a paint brush). 



How to Rank and Value Fantasy Baseball Players for Points Leagues   

Page | 23 
 

Step Description 
Format Painter allows you to copy all formatting from one cell to the next 
selected cell.  If you double-click on Format Painter, you can continue to click 
on many cells and they will all take on the formatting (a lot of people who 
know about Format Painter don't know about the double-click option!). 

We're going to use Format Painter to make all the other point values blue and 
outlined. 

  

While the Format Painter is still active (you can tell it's active when you see 
the paint brush icon next to your cursor), simply click in all the other cells 
containing scoring point values.  

  

After you have selected all the point value cells, hit your ESC key to exit the 
Format Painter. 

7. In order to calculate projected points for all players, we will need to reference 
and use these scoring values in future formulas. 

To make it easier to reuse these figures, we will set them up as Named 
Cells.  To do this, first click on one of your hitter point values (I'll use B2 from 
my example). 
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Step Description 

 
Then click on the "Formulas" tab of the ribbon and select the "Define Name" 
button 

.  

8. In the window that pops up, enter a meaningful name that you'll later be able 
to recognize.  For example, to name the point value for At Bats, I chose the 
name "H_PTS_AB". 

This will indicate this is the point value for hitter at bats. 

Click OK to save this name. 

 
9. Repeat this process for all of your hitting and pitching point values. 

I used these names for my hitting categories: 

• H_PTS_AB 
• H_PTS_H 
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Step Description 
• H_PTS_BB 
• H_PTS_2B 
• H_PTS_3B 
• H_PTS_HR 
• H_PTS_SB 

I used these names for my pitching categories: 

• P_PTS_IP 
• P_PTS_K 
• P_PTS_BB 
• P_PTS_HA 
• P_PTS_SV 
• P_PTS_HD 
• P_PTS_HRA 

Note that Excel will not allow you to start a Name with a number (so you 
couldn't name your cell "2B_PTS_H"). 

It may be a good idea to view the list of all names in your Excel file when 
you're done.  To do this, click on the "Name Manager" button of the 
"Formulas" tab. 

   

Look over your list of names and make sure you haven't missed anything. 
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Step Description 

 
10. We're done. Save the file. 

WRAP UP 

At this point in the process we have a file with projections, player IDs, and our 
league scoring settings.  In the next part of this book we'll start pulling the 
projection information into new sheets where we can begin to calculate each 
player's projected points for the season. 

DO YOU HAVE ANY QUESTIONS? 

Do you have questions about Part 2?  Or want to see what others have asked?  
Check here. 

EXAMPLE EXCEL FILE 

Download the example spreadsheet illustrating the work done in this part 
here.  Or you can download all spreadsheets for the entire book here.  

http://www.smartfantasybaseball.com/2015/01/how-to-calculate-rankings-for-a-points-league-part-2-league-scoring-settings/%23comment-971
http://www.smartfantasybaseball.com/points2
http://www.smartfantasybaseball.com/jzv0
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PART 3 – VLOOKUP, EXCEL TABLES, AND 
STRUCTURED REFERENCES 

INTRODUCTION 

In this part of the book we'll use Excel's VLOOKUP and IFERROR formulas as 
well as Table and Structured Reference features to pull hitter information and 
projections from other areas of the spreadsheet in order to create our hitter 
rankings tab. 

EXCEL FUNCTIONS AND FORMULAS IN THIS PART 

Below are the Excel functions and formulas used in this part of the book. If 
you're already familiar with what these are, you can skip ahead to the step-by-
step instructions. 

VLOOKUP 

One of the most powerful Excel formulas, in my opinion. And it's easier to 
use than you might think. 

This formula searches the first column of a table for a desired value (a 
player ID) and then returns a value that is in the same row but in a separate 
column. For example, we might tell Excel to go into a table of projection 
data, locate the player ID for Billy Hamilton (10199), and give us back the 
number in the fourteenth column (column N, which holds the number of 
SBs). 

 

This formula requires four inputs: 

VLOOKUP(lookup_value, table_array, col_index_num, 
range_lookup) 
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1. Lookup_value - This is the value we want to search for in the table of 
data (e.g. Billy Hamilton's player ID 10199). In the rankings spreadsheet, 
we're mostly going to use player IDs for this. "Hey Excel, go look for this 
player ID". 

2. Table_array - This has to be two or more columns of data. Excel will look 
for the Lookup_value in the first column in the set of data. You do not 
necessarily need this to be the first column on a spreadsheet tab (you don't 
have to use Column A of a sheet, the first column of your Table_array could 
be Column G). But Excel is going to look through the first column you 
provide. "Hey Excel, here are fifteen columns of data for you, look through 
everything in the first column for the Lookup_value." 

3. Col_index_num - This is the column number of the Table_array that 
contains your desired information. This has to be a number and it has to be 
within the Table_array you provided. For example, if your table_array only 
has five columns, but you put a six for Col_index_num, you'll have a 
problem. "Hey Excel, the fourteenth column has projected stolen bases. 
After you find Billy Hamilton's player ID, tell me how many stolen bases are 
in that fourteenth column." 

4. Range_lookup - This input can be either "TRUE" or "FALSE". If you use 
"TRUE", Excel will look for an approximate match of the lookup_value 
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(PLAYERID). If you enter "FALSE", Excel will only look for an exact match. 
This is an optional input, but I feel very strongly that it must be used and 
that "FALSE" is the option selected. You may otherwise get the wrong 
projections showing up for players. 

TABLES (NAMED RANGES, STRUCTURED REFERENCES)  

Similar to how we named individual cells in Part 2, Excel has functionality 
that allows you to convert a block of data (player projections) into a named 
table. There are quite a few benefits to using tables: 

Tables have names.  This is great for the Table_array input in the 
VLOOKUP formula. We can give the projection sheet the name 
"STEAMER_H" (for Steamer Hitters projections) and use that instead of 
traditional way of selecting data in Excel (if we didn’t use “STEAMER_H 
we would have to use something like 'Steamer Hitters'!A1:W500).  Not only 
is this a huge time saver (using your mouse to scroll and select 20 columns 
and 500 rows takes a long time), but it gives your formulas meaning.  When 
you look back at your VLOOKUP formula and see "STEAMER_H", you'll 
easily be able to remember that you're looking up projected Steamer hitter 
information. 

Columns have names. I have a hard time remembering what column 
projected HRs are in. But I don't need to if I know that the column name is 
"HR". If you don't use a table, you're stuck trying to remember things like, 
"were HRs in column G, H, or I?". And even if you remember the column 
letter, then you have to figure out if column I is column number 8, 9, or 
10?  When referring to a column, use the following convention - 
TABLENAME[COLUMNNAME]. The column name is surrounded in 
brackets. 

Formula consistency. In a table, all formulas within a column are 
identical. When you change the formula in one cell of a column, the rest of 
the column automatically updates too. No more editing a formula in one 
cell and having to copy it to hundreds of other cells in the same column. 

Easy sorting and filtering. When you create a table the filter drop down 
menus appear automatically.  Sorting and filtering is as easy as clicking a 
drop down arrow. 
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COLUMN 

This function returns the column number of a cell or range of data. The 
function only requires one input; the cell or range to be evaluated: 

COLUMN(TableName[ColumnName]) 

Let's use a real example to illustrate: 

COLUMN(STEAMER_H[SB]) 

This formula will look for the stolen bases column in the Steamer Hitter 
Projections and will return the column number.  If SB are in column N, this 
formula calculates to 14. 

See how this formula converts column N into an easy to use number?  
We’re going to combine this with the VLOOKUP formula mentioned above. 

IFERROR 

The IFERROR function allows us to control what happens when another 
formula being used is calculating out to an error. 

The image below is a great example of this. In this spreadsheet we have a 
series of VLOOKUP formulas that instruct Excel to go find Kendrys 
Morales’ player ID (moralke01) in the “Steamer Projections” tab. 

You may recall that during the 2014 season Morales remained an unsigned 
free agent until well into the season, so he was not included in the Steamer 
projections at that time. Because he was not included, the VLOOKUP 
formula could not find his player ID and could only calculate to this "#N/A" 
error message. 
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The IFERROR function will allow us to replace the error message with any 
value of our choice. It essentially works by telling Excel, “If this other 
formula I’m using comes back with an error, use this instead”. 

Using IFERROR we could instead make Kendrys Morales line look like this: 

 

The formula requires two inputs: 

IFERROR(value, value_if_error) 

Value – This represents the formula or calculation we want Excel to 
perform. In our example above it will be the same VLOOKUP formula we 
already have entered. 

Value_if_error – This represents the value or message we want Excel to 
return if the first argument, “Value”, happens to be an error. In our 
example above we don’t want the default “#N/A” error message that turns 
up if Excel cannot locate Kendrys Morales in the RoS projections. Instead, 
we could just ask for Excel to return zeroes for his projected stats. 

STEP-BY-STEP INSTRUCTIONS 

Step Description 
1. Go to the "Steamer Hitters" tab of your Excel file. 

We will convert this to a “table” in Excel in order to make the data easier to 
work with. 

Click anywhere within the projection data. Then locate the “Home” tab in the 
Excel menu system. 

Click once on the “Format as Table” drop down, and then select your desired 
color scheme. 
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Step Description 

 
You will then be prompted to verify the range of cells in the table and that 
your table has a header row (e.g. Name, AB, H, HR, etc.). 

You might notice that my example projection data goes out to column AC. 
Yours may have more or less columns. I believe the Steamer downloads 
contain additional information at certain times of the year, but if you look 
closely at the information in the rightmost columns, they're things we don't 
care about for fantasy (wRC+, WAR calculations, etc.). 

As long as you have the main offensive categories and the "playerid" column, 
you're good. 

 
Check “My table has headers”. Click OK. 
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Step Description 
After accepting this, your bland looking data will transform into a nicely 
formatted table. 

 
2. We’ll later be pulling information from this table into other worksheets. To 

make the pulling of data easier we need to move the Fangraphs player ID to be 
the first column (you can use VLOOKUP if the player ID is in the first column, 
otherwise you’re stuck using more difficult and/or multiple formulas).  

Right-click on the top of the Fangraphs player ID column (I right clicked on 
the “AC” column header) and Cut it. 

 
3. Now right-click on the top of the player name column (column header “A”) 

and select “Insert Cut Cells”. 
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Step Description 

 
4. Before we finalize this table, we should give it a name we can refer to in the 

future. Go to the “Formulas” tab on the Excel ribbon and click on the “Name 
Manager” button. 

 
5. Because we created named cells in Part 2 of the book, it might be helpful to 

filter the Name Manager to only show table names. Do this by clicking the 
"Filter" drop down menu in the top right of the window. Then choose "Table 
Names". 
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Step Description 

 
Excel will give very generic names to a table, like “Table2″.  

It’s more helpful to give meaningful names to your tables. As you get more 
tables in a spreadsheet, it can become very difficult to remember the 
difference between “Table2″ and “Table3″.  

Note how there is already a table named “PLAYERIDMAP”. I previously set 
up this table before you inserted it into your Excel file in Part 1 of this book. 

 
Select your table from the list (it will probably be named "Table2") and click 
on the “Edit…” button. 

6. Give the table a meaningful name. I chose “STEAMER_H” to indicate these 
are the Steamer Hitter projections. 
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Step Description 

 
Click “OK” to close the “Edit Name” menu. Then click “Close” to exit the 
“Name Manager”. 

7. We now have two tables ready to pull hitter information from, 
PLAYERIDMAP and STEAMER_H. 

I’m going to pull and combine from these two tables into a new tab where I’ll 
calculate the hitter rankings. 

If you're wondering why I'm going through all of this trouble to set up 
multiple tabs and to keep all of this information separated, it's because I want 
this whole spreadsheet to be usable in future seasons. 

By keeping the PLAYERIDMAP in one area, projections in another, and 
rankings in another, we'll be able to easily update each of those components at 
later times. 

This spreadsheet can be used in the middle of the season to drop in Rest of 
Season Projections.  It can easily be tweaked a little and used next year. 

You can read more about my design philosophy here. 

8. Right click on the “PLAYERIDMAP” tab and select the option to “Insert…”. 

http://www.smartfantasybaseball.com/2014/08/designing-reusable-fantasy-baseball-spreadsheets/
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Step Description 

 
Choose the “Worksheet” option and click “OK”. 

 
9. Right click on the new sheet tab and choose to “Rename”. Call this sheet 

“Hitter Ranks”. 
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Step Description 
After you've renamed the sheet, type "PLAYERID" into cell A1. This will be a 
column header for our next step. 

 
10. As we talked about in the first part of this book, I like to use Baseball-

Reference player IDs as the main ID system in my spreadsheets.  That's 
because I can usually look at an ID and know who the player is (e.g. encared01 
is Edwin Encarnacion). 

We want the first column of this new sheet to contain the Baseball Reference 
player ID and we only want hitters at this time. The PLAYERIDMAP sheet has 
a list of all fantasy-relevant players (for standard rotisserie leagues, at least). 
However, this sheet contains pitchers also. Because this sheet is an Excel 
table, it’s easy to filter out those pitchers. 

Click on the drop down arrow on the “POS” column. You’ll be presented with 
a list of all the positions. Uncheck the “P” value (for pitchers). Click OK to 
apply the filter. 
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Step Description 

 
The Player ID Map will now list only hitters. 

11. Starting at the first player and ending with the last, click and drag within the 
“IDPLAYER” column (first column) and select all players (or select the first 
player and then use the keyboard shortcut SHIFT + CTRL + Down 
Arrow). Only select from this first column. 

Note, I also added a dummy player name "Last Player".  You don't need to 
grab him, but it won't hurt if you do. 

 
12. Copy this selected data. Return to the “Hitter Ranks” sheet. Then paste the 

data into cell A2. 
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Step Description 

 
13. Now that we’re starting this new sheet, we should convert it to an Excel table. 

We will essentially repeat step 1 above, but for this new worksheet. 

Click once to select any player ID. Then locate the “Home” tab in the ribbon. 

Click once on the “Format as Table” drop down and then select your desired 
color scheme. 

 
14. You will then be prompted to verify the range of cells in the table and that 

your table has a header row. 
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Step Description 

 
Check “My table has headers”. Click OK. 

15. Repeat steps 4-6 in order to give the table a more meaningful name. In my 
example, Excel defaulted the table name to “Table3″. I renamed mine to be 
“MYRANKS_H” (to indicate hitter ranks, because we’ll also be ranking 
pitchers). 

 
16. Now for the fun part… pulling data from the other tabs. I’ll first add “Player 

Last Name” to the table. 
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Step Description 
To expand your table, simply type “LNAME” into cell B1 and hit Enter (I typed 
into cell B1). Excel should automatically pull this new column into your table.  

 
17. Your table shading may look like this instead of the image from step 16 (which 

has alternating shaded and non-shaded rows): 

 
If so, click once in the area between the Column "A" header and the Row "1" 
header (the top left corner of all cells), to select all cells in the entire sheet. 

 
Then click the "Fill Color" icon (looks like a paint can) drop down arrow and 
choose the "No Fill" option. 

http://www.smartfantasybaseball.com/wp-content/uploads/2015/01/SELECT_ALL_CELLS1.png
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Step Description 

 
You should now see the proper alternating color scheme. 

 
18. Our goal in Column B is to instruct Excel to take the PLAYERID from column 

A (e.g. "abreujo01"), go into the first column of PLAYERIDMAP, find the 
matching PLAYERID, and then pull back the corresponding LASTNAME. You 
can see in the image of the PLAYERIDMAP below that LASTNAME is in the 
fifth column (column E). 

http://www.smartfantasybaseball.com/wp-content/uploads/2015/01/NO_FILL.png
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Step Description 

 
To start building the formula, click in cell B2 of your Hitter Ranks tab. Then 
click the “fx” button of the formula bar to launch Excel’s formula wizard. We’ll 
use the wizard the first time through to better explain this function in Excel. 

 

19. Type “vlookup” into the search bar and click “Go”. When the function appears, 
make sure it is selected and hit “OK”. You should then see the different 
arguments, or components, needed for the formula to work. 
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Step Description 
20. The “Lookup_value” is the value on the “Hitter Ranks” sheet that we want to 

locate (or match to) in the “PLAYERIDMAP”. 

Click once in the “Lookup_value” field. Then click on the value in cell A2 
(“abreubo01″). 

Excel will convert this to [@PLAYERID]. This naming convention is referred 
to as a "Structured Reference" or a "Table Reference" and can be used when 
you have converted your data into an Excel table.  

 
21. The “Table_array” field is the table (or array, or block of data) in which to go 

look for the matching PLAYERID. Because the PLAYERIDMAP sheet was 
previously set up as a table, we can take advantage of this. 

Click once in the “Table_array” field. Simply type “PLAYERIDMAP” (no 
quotes). Again, this is another benefit of using Excel tables. It’s much easier to 
type in the table name than it is to flip tabs in Excel and select a giant range of 
data with your mouse. 
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Step Description 

 
You'll know you got this right if you see part of the PLAYERIDMAP 
populating to the right of the Table_array field. 

 
22. The “Col_index_num” field wants to know the number of the column in the 

PLAYERID map table to retrieve data from. 

Again, our goal is to retrieve LASTNAME from the PLAYERIDMAP table, 
which is column 5 in that table. You could manually flip back and forth 
between tabs to determine the column number. You could then just type a "5" 
in for “Col_index_num”. 

This takes time and can be difficult if you start getting into column X (do you 
know what number letter of the alphabet that is?).  It's also a BIG problem if 
you later add a column that would push LASTNAME into column number 6.   

For these reasons, I prefer to use the COLUMN formula.  When this is entered 
into the Col_index_num field, it will calculate the location of the LASTNAME 
column.  We don't have to flip back and forth and if LASTNAME gets shifted 
to another column, this formula will adjust automatically. 

The formula below will determine that LASTNAME is the fifth column in the 
PLAYERIDMAP table. 
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COLUMN(PLAYERIDMAP[LASTNAME]) 

Enter this equation into the Col_index_num field. 

 
23. Finally, we have the Range_lookup argument. I always enter “FALSE” for this 

in order to ensure Excel only locates exact matches for a PLAYERID. I don’t 
want Excel to return an approximate match if the exact PLAYERID cannot be 
found.  Giving me Bobby Abreu's projection instead of Jose Abreu's would not 
be helpful... 

 

24. Before hitting “OK” to accept the formula, you can preview the output. In this 
case we are dealing with “abreubo01″, or Bobby Abreu, and can see the 
formula appears to be working (look at the tip of the mouse pointer below). 
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Step Description 

 
Click OK to accept the formula. 

Once the formula is entered, it should automatically copy to the remaining 
rows of the table. 

 
25. We will use the VLOOKUP formula to pull additional data and the majority of 

the formula will remain the same. 

To add a FNAME column, type the "FNAME" into cell C1. Copy the formula 
from cell B2. Don't click and drag it.  Actually right-click on B2 to copy it or 
use the CTRL + C shortcut.   

Paste the formula into cell C2.  When you copy and paste the formula this way 
you should end up with two columns displaying player last names.  That's 
what you want for now! 
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Step Description 

 
Then simply double click in cell C2 and change the column name (remember 
column names are surrounded in [brackets]. So change [LASTNAME] to 
[FIRSTNAME].). 

 
Nerdy Excel talk here, but dragging formulas within tables does not work very 
well because there's no way to make the formulas absolute (they want to stay 
relative as you move them).  That's why I suggest copying and pasting the 
formula, even if it duplicates and you then need to change part of it. 

26. Repeat step 25 to pull TEAM, POS, and IDFANGRAPHS from the 
PLAYERIDMAP tab. 

If you can’t remember the exact name of a column, once you have entered a 
table name, like PLAYERIDMAP, and the opening “[" bracket, a helpful type 
ahead box will display all the column names in the PLAYERIDMAP table (see 
the image below showing the type ahead box). 

You can use the mouse to double-click on the column name in the type ahead 
list or select a column name and hit the Tab key to add it to your formula. 
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Step Description 

 
The exact formulas you want for TEAM, POS, and IDFANGRAPHS are: 

TEAM: 

=VLOOKUP([@PLAYERID],PLAYERIDMAP, 
COLUMN(PLAYERIDMAP[TEAM]),FALSE) 

POS: 

=VLOOKUP([@PLAYERID],PLAYERIDMAP, 
COLUMN(PLAYERIDMAP[POS]),FALSE) 

IDFANGRAPHS: 

=VLOOKUP([@PLAYERID],PLAYERIDMAP, 
COLUMN(PLAYERIDMAP[IDFANGRAPHS]),FALSE) 

27. We've now pulled all the relevant information from PLAYERIDMAP and can 
begin pulling in hitter projections from our STEAMER_H table. 

Add column headers for columns where we will pull plate appearances (PA), 
at bats (AB), hits (H), home runs (HR), runs (R), runs batted in (RBI), walks 
(BB), strikeouts (SO), stolen bases (SB), and any other counting stat 
categories used in your league's scoring system (e.g. 2B, 3B, CS, etc.). 
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Step Description 
There will be some tweaks to the VLOOKUP formula we used earlier. First, 
the Steamer projections use Fangraphs ID numbers. So we will be using the 
IDFANGRAPHS column as the Lookup_value. 

Second, we must specify to pull from the Steamer Hitters projections 
(STEAMER_H table name). 

And finally, the COLUMN formula will change to determine what statistic to 
pull. 

 
Your final Plate Appearance formula should be: 

=VLOOKUP([@IDFANGRAPHS], STEAMER_H, 
COLUMN(STEAMER_H[PA]), FALSE) 

28. After you accept the formula above, you may encounter a situation where the 
VLOOKUP formula will return "#N/A" for certain players. 

This error means that Excel could not find the value you told it to look up. In 
this example image below, Garrett Atkin's player ID was not found in the 
projections (probably because he's retired). 

 
These errors can cause big problems with the rankings. It would be better to 
have the PA, HR, and RBI for a player to be zero or blank. 

To accomplish this, we can use the "IFERROR" formula and wrap it around 
our original VLOOKUP formula. 

This is the original formula in the cell: 
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Step Description 
=VLOOKUP([@IDFANGRAPHS],STEAMER_H, 

COLUMN(STEAMER_H[PA]),FALSE) 

Now surround the VLOOKUP formula with the IFERROR formula. The 
original VLOOKUP formula will remain exactly as is. I will just put 
"IFERROR(" in front of it. And behind the existing formula I will put ",0)". 

=IFERROR(VLOOKUP([@IDFANGRAPHS],STEAMER_H, 
COLUMN(STEAMER_H[PA]),FALSE),0) 

You can see the edits I made in the red bolded font. That’s all you have to do. 
Excel will now perform the exact same calculation as before, but if a player 
cannot be located in the VLOOKUP, Excel will put 0 instead of #N/A. 

I recommend using a 0, but if you want it to be a blank instead of a zero, use 
this: 

=IFERROR(VLOOKUP([@IDFANGRAPHS],STEAMER_H, 
COLUMN(STEAMER_H[PA]),FALSE),"") 

29. The formulas for AB, H, 2B, 3B, HR, R, RBI, BB, SO, and SB are shown below. 

AB: 

=IFERROR(VLOOKUP([@IDFANGRAPHS],STEAMER_H, 
COLUMN(STEAMER_H[AB]),FALSE),0) 

H: 

=IFERROR(VLOOKUP([@IDFANGRAPHS],STEAMER_H, 
COLUMN(STEAMER_H[H]),FALSE),0) 

2B: 

=IFERROR(VLOOKUP([@IDFANGRAPHS],STEAMER_H, 
COLUMN(STEAMER_H[2B]),FALSE),0) 

3B: 

=IFERROR(VLOOKUP([@IDFANGRAPHS],STEAMER_H, 
COLUMN(STEAMER_H[3B]),FALSE),0) 

HR: 
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=IFERROR(VLOOKUP([@IDFANGRAPHS],STEAMER_H, 

COLUMN(STEAMER_H[HR]),FALSE),0) 

R: 

=IFERROR(VLOOKUP([@IDFANGRAPHS],STEAMER_H, 
COLUMN(STEAMER_H[R]),FALSE),0) 

RBI: 

=IFERROR(VLOOKUP([@IDFANGRAPHS],STEAMER_H, 
COLUMN(STEAMER_H[RBI]),FALSE),0) 

BB: 

=IFERROR(VLOOKUP([@IDFANGRAPHS],STEAMER_H, 
COLUMN(STEAMER_H[BB]),FALSE),0) 

SO: 

=IFERROR(VLOOKUP([@IDFANGRAPHS],STEAMER_H, 
COLUMN(STEAMER_H[SO]),FALSE),0) 

SB: 

=IFERROR(VLOOKUP([@IDFANGRAPHS],STEAMER_H, 
COLUMN(STEAMER_H[SB]),FALSE),0) 

30. I don’t pull batting average or any other rate statistics (OBP, SLG, etc.) 
directly from the projections. I prefer to recalculate them with a formula after 
the underlying statistics have been pulled. 

To do this, type “BA” in as a column header. Then enter the formula to 
calculate batting average (=[@H]/[@AB]). 

 
If you're not exactly sure of the convention for the formulas you can always 
use your mouse to click on the values in the "H" and "AB" columns and Excel 
will translate it into the =[@H]/[@AB] format for you. 
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Step Description 
Repeat this step for any other rate statistics you desire (OBP, SLG, OPS, etc.). 

You might notice that these rate formulas can also result in errors if a player 
does not have a projection (dividing by 0 causes an error). You can use the 
IFERROR formula around the calculation to clean this up. 

Here are the formulas I use for AVG, OBP, and SLG: 

AVG: 

=IFERROR([@H]/[@AB],0) 

OBP: 

=IFERROR(([@H]+[@BB]+[@HBP])/([@AB]+[@BB]+[@HBP]),0) 

SLG: 

=IFERROR(([@H]+[@2B]+2*[@3B]+3*[@HR])/[@AB],0) 

31. Most statistics don’t need formatting, but AVG and the other rate statistics 
will. In my file, AVG is located in column "S".   

Click on the “S” column label (or whatever column AVG is in) to select the 
entire AVG column. Then on the Home tab of the ribbon, click on the comma 
number format. 

 
Finally, click on the symbol to increase the decimal places from two to three 
(the standard batting average format). 
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Step Description 

 
32. Save the file. 

You’ve now successfully combined hitter information and projected hitting 
stats into one table. 

WRAP UP 

At this point we have pulled the hitter projections into our rankings tab that 
we will eventually calculate each player's projected points on. 

In the next part of the book we will follow these exact same steps with pitchers 
in order to develop our pitcher rankings worksheet. 

DO YOU HAVE ANY QUESTIONS? 

Do you have questions about Part 3?  Or want to see what others have asked?  
Check here. 

EXAMPLE EXCEL FILE 

Download the example spreadsheet illustrating the work done in this part 
here.  Or you can download all spreadsheets for the entire book here.  

PART 4 – PITCHER RANKINGS 
INTRODUCTION 

In this part of the book we will again use Excel's VLOOKUP and IFERROR 
formulas as well as Table and Structured Reference features, but this time to 
pull pitcher information and projections to create our pitcher rankings tab. 

http://www.smartfantasybaseball.com/2015/01/how-to-calculate-rankings-for-a-points-league-part-3-vlookup-excel-tables-and-structured-references/%23comment-972
http://www.smartfantasybaseball.com/points3
http://www.smartfantasybaseball.com/jzv0
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EXCEL FUNCTIONS AND FORMULAS IN THIS PART 

This is where I normally give detailed explanations of each Excel feature and 
formula used in the instructions below; however, we're not introducing 
anything new in Part 4. If you would like more background on the features and 
formulas used below, please refer to Part 3 or ask questions in the comments 
area mentioned below. 

STEP-BY-STEP INSTRUCTIONS 

Step Description 

1. Go to the “Steamer Pitchers” tab of your Excel file. 

We will convert this to a “table” in Excel in order to make the data easier to work 
with. 

Click anywhere within the pitcher projection data. Then locate the “Home” tab 
in the Excel menu system (“the ribbon”). 

Click once on the “Format as Table” drop down, and then select your desired 
color scheme. 
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Step Description 

You will then be prompted to verify the range of cells in the table and that your 
table has a header row (e.g. Name, W, L, ERA, etc.). 

You might notice that my example projection data goes out to column T. Yours 
may have more or less columns. I believe the Steamer downloads contain 
additional information at certain times of the year, but if you look closely at the 
information in the rightmost columns, they're things we don't care about for 
fantasy (WAR calculations, etc.). 

As long as you have the main pitching categories needed for your league's 
scoring system and the "PLAYERID" column, you're good. 

 
Check “My table has headers”. Click OK. 

After accepting this, your bland looking data will transform into a nicely 
formatted table. 
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Step Description 

 
2. We’ll later be pulling information from this table into other worksheets. To make 

the pulling of data easier we need to move the Fangraphs player ID to be the first 
column (you can use VLOOKUP if the player ID is in the first column, otherwise 
you’re stuck using more difficult and/or multiple formulas).  

Right-click on the top of the Fangraphs player ID column (I right-clicked on the 
“T” column header) and cut it. 

 
3. Now right-click on the top of the player name column (column header “A”) and 

select “Insert Cut Cells”. 
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Step Description 

 
4. Before we finalize this table, we should give it a name we can refer to in the 

future. Go to the “Formulas” tab on the Excel ribbon and click on the “Name 
Manager” button. 

 
5. Because we created named cells in Part 2 of the book, it can be difficult to locate 

the tables in the Name Manager.  I find it helpful to filter the Name Manager to 
only show table names. Do this by clicking the "Filter" drop down menu in the 
top right of the window. Then choose "Table Names". 
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Step Description 

Excel will give very generic names to a table, like “Table2″. It’s more helpful to 
give meaningful names to your tables. As you get more tables in a spreadsheet, it 
can become very difficult to remember the difference between “Table2″ and 
“Table3″. 

Select your table from the list (it should be the only one named "Table#") and 
click on the "Edit..." button. 

 
6. Give the table a meaningful name. I chose “STEAMER_P” to indicate these are 

the Steamer Pitcher projections. 

 
Click “OK” to close the “Edit Name” menu. Then click “Close” to exit the “Name 
Manager”. 

7. We now have the PLAYERIDMAP and STEAMER_P tables in a format where we 
can pull information from them. 

I’m going to pull from these two tables into a new tab where I’ll calculate the 
pitcher rankings. 
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Step Description 

8. Right click on the “PLAYERIDMAP” tab and select the option to “Insert…”. 

 
Choose the “Worksheet” option and click “OK”. 

 
9. Right click on the new sheet tab and choose to “Rename”. I’ll call this sheet 

“Pitcher Ranks”. 
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Step Description 

 
After you've renamed the sheet, type "PLAYERID" into cell A1.  This will be a 
column header for our next step. 

 
10. As we have talked about before, I like to use Baseball-Reference player IDs as 

the main ID system in my spreadsheets. This is so I can look at an ID and know 
who the player is (e.g. kershcl01 is Clayton Kershaw).  

To make it the main ID we want the first column of this new sheet to contain the 
Baseball Reference player ID and we only want pitchers at this time. The 
PLAYERIDMAP sheet has a list of all fantasy-relevant players (for standard 
rotisserie leagues, at least) and their Baseball Reference IDs. However, this sheet 
contains hitters also. Just like in the last chapter, we now want to filter out those 
hitters.  

Click on the drop down arrow on the “POS” column. You’ll be presented with a 
list of all the positions.  

Check the "(Select All)" box until all the positions below become 
unchecked.  Then check the "P" box.   
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Step Description 

Click OK to apply the filter. 

 
The Player ID Map will now list only pitchers. 

11. Starting at the first player and ending with the last, click and drag within the 
“IDPLAYER” column (first column) and select all player (or select the first 
player and then use the keyboard shortcut SHIFT + CTRL + Down Arrow). Only 
select from this first column. 

 
12. Copy this selected data. Return to the “Pitcher Ranks” sheet. Then paste the data 

into cell A2. 
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Step Description 

 
13. Now that we’re starting this new sheet, we should convert it to an Excel table. 

We will essentially repeat step 1 above, but for this new worksheet. 

Click once to select any player ID. Then locate the “Home” tab in the Excel menu 
system (“the ribbon”). 

Click once on the “Format as Table” drop down, and then select your desired 
color scheme. 

 
14. You will then be prompted to verify the range of cells in the table and that your 

table has a header row.  
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Step Description 

 
Check “My table has headers”. Click OK. 

15. Repeat steps 4-6 in order to give the table a more meaningful name. In my 
example, Excel defaulted the table name to “Table6″. I renamed mine to be 
“MYRANKS_P” (to indicate pitcher ranks, because we already ranked hitters). 
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Step Description 

16. Now let's begin pulling data from the other tabs. I’ll first add “Player Last Name” 
to the table. To expand your table, simply type into column B and hit Enter (I 
typed into cell B1). Excel should automatically pull this new column into your 
table. I’m going to name my column “LNAME”. 

 
17. Your table shading may look like this instead of the image from step 16: 

 
If so, click once in the area between the Column "A" header and the Row "1" 
header (the top left corner of all cells), to select all cells in the entire sheet. 

 
Then click the "Fill Color" icon (looks like a paint can) drop down arrow and 
choose the "No Fill" option. 
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Step Description 

 
You should now see the proper alternating color scheme. 

 
18. Our goal in column B is to instruct Excel to take the PLAYERID from column A, 

go into the first column of PLAYERIDMAP, find the matching PLAYERID, and 
then pull the corresponding LASTNAME. You can see in the image of the 
PLAYERIDMAP below that LASTNAME is in the fifth column (column E). 
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To start building the formula, click in cell B2 of your Pitcher Ranks tab. Then 
click the “fx” button of the formula bar to launch Excel’s formula wizard. We’ll 
use the wizard the first time through to better explain this function in Excel. 

 
19. Type “vlookup” into the search bar and click “Go”. When the function appears, 

make sure it is selected and hit “OK”. You should then see the different 
arguments, or components, needed for the formula to work. 
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Step Description 

 
20. The “Lookup_value” is the value on the “Pitcher Ranks” sheet that we want to 

locate (or match to) in the “PLAYERIDMAP”. 

Click once in the “Lookup_value” field. Then click on the value in cell A2 
(“aardsda01″). 

Excel will convert this to [@PLAYERID]. As we talked about in Part 3, this 
naming convention is referred to as a "Structured Reference" or a "Table 
Reference" and can be used when you have converted your data into an Excel 
table. 
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Step Description 

 
21. The “Table_array” field is the table (or array, or block of data) in which to go 

look for the matching PLAYERID. Because the PLAYERIDMAP sheet was 
previously set up as a table, we can take advantage of this. 

Click once in the “Table_array” field. Simply type “PLAYERIDMAP” (no 
quotes).  
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Step Description 

You'll know you got this right if you see part of the PLAYERIDMAP populating 
to the right of the Table_array field. 

 
  

22. The “Col_index_num” field wants to know the number of the column in the 
PLAYERID map table to retrieve data from. 

For the reasons we discussed in the last section, I prefer to use the COLUMN 
formula. When this is entered into the Col_index_num field, it will calculate the 
location of the LASTNAME column.   

The formula below will determine that LASTNAME is the fifth column in the 
PLAYERIDMAP table. 

COLUMN(PLAYERIDMAP[LASTNAME]) 

Enter this equation into the Col_index_num field.  

 
23. Finally, we have the Range_lookup argument. I always enter “FALSE” for this in 

order to ensure Excel only locates exact matches for a PLAYERID. I don’t want 
Excel to return an approximate match if the exact PLAYERID cannot be found. 
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Step Description 

 
24. Before hitting “OK” to accept the formula, you can preview the output. In this 

case we are dealing with “aardsda01″, or David Aardsma (fantasy stud, right?), 
and can see the formula appears to be working (you can see the end result of this 
formula is {"Aardsma"}. 

 
Click OK to accept the formula. 

Once the formula is entered, it should automatically copy to the remaining rows 
of the table. 
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Step Description 

 
25. We will use the VLOOKUP formula to pull additional data, and the majority of 

the formula will remain the same. To add a FNAME column, type the 
"FNAME" into cell C1. Copy the formula from cell B2. 

Don't click and drag it.  Actually right-click on B2 to copy it or use the CTRL + C 
shortcut.  Paste the formula into cell C2.  When you copy and paste the formula 
this way you should end up with two columns displaying player last 
names.  That's what you want for now! 

 
Then simply double click in cell C2 and change the column name (remember 
column names are surrounded in [brackets]. So change [LASTNAME] to 
[FIRSTNAME].). 
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Step Description 

26. Repeat step 25 to pull TEAM, POS, and IDFANGRAPHS from the 
PLAYERIDMAP tab. 

Remember you can use the type ahead list to select a column name. Hit the Tab 
key to add it to your formula. 

 
The exact formulas you want are: 

TEAM: 

=VLOOKUP([@PLAYERID],PLAYERIDMAP, 
COLUMN(PLAYERIDMAP[TEAM]),FALSE) 

POS: 

=VLOOKUP([@PLAYERID],PLAYERIDMAP, 
COLUMN(PLAYERIDMAP[POS]),FALSE) 

IDFANGRAPHS: 

=VLOOKUP([@PLAYERID],PLAYERIDMAP, 
COLUMN(PLAYERIDMAP[IDFANGRAPHS]),FALSE) 

27. We've now pulled all the relevant information from the PLAYERIDMAP and can 
now begin pulling in pitcher projections from our STEAMER_P table. 
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Step Description 

Add column headers for where we can pull wins (W), games started (GS), saves 
(SV), innings pitched (IP), hits (H), earned runs (ER), home runs (HR), 
strikeouts (SO), walks (BB), fielding independent pitching (FIP), and any other 
counting stat categories used in your league's scoring system (e.g. L). 

 
There will be some tweaks to the VLOOKUP formula we used earlier. First, the 
Steamer projections use Fangraphs ID numbers. So we will be using the 
IDFANGRAPHS column as the Lookup_value. 

Second, we must specify to pull from the Steamer Pitchers projections 
(STEAMER_P table name). 

And finally, the COLUMN formula will change to determine what statistic to pull 

 
Your final Wins formula should be: 

=VLOOKUP([@IDFANGRAPHS], STEAMER_P, 
COLUMN(STEAMER_P[W]), FALSE) 

28. After you accept the formula above, you may encounter a situation where the 
VLOOKUP formula will return "#N/A" for certain players. 

This error means that Excel could not find the value you told it to look up. In 
this example image below, Chris Carpenter's player ID was not found in the 
projections (probably because he's retired). 



How to Rank and Value Fantasy Baseball Players for Points Leagues   

Page | 76 
 

Step Description 

 
These errors can cause big problems with the rankings. It would be better to 
have the W, ER, and SO's for a player to be zero or blank. 

To accomplish this, we can use the "IFERROR" formula and wrap it around our 
original formula. 

This is the original formula in the cell: 

=VLOOKUP([@IDFANGRAPHS],STEAMER_P, 
COLUMN(STEAMER_P[W]),FALSE) 

Surrounding the VLOOKUP formula with the IFERROR formula we get: 

=IFERROR(VLOOKUP([@IDFANGRAPHS],STEAMER_P, 
COLUMN(STEAMER_P[W]),FALSE),0) 

I recommend using a 0, but if you want it to be a blank instead of a zero, use 
this: 

=IFERROR(VLOOKUP([@IDFANGRAPHS],STEAMER_P, 
COLUMN(STEAMER_P[W]),FALSE),"") 

29. The formulas for GS, SV, IP, H, ER, HR, SO, BB, and FIP are shown below. 

GS: 

=IFERROR(VLOOKUP([@IDFANGRAPHS],STEAMER_P, 
COLUMN(STEAMER_P[GS]),FALSE),0) 

SV: 

=IFERROR(VLOOKUP([@IDFANGRAPHS],STEAMER_P, 
COLUMN(STEAMER_P[SV]),FALSE),0) 

IP: 

=IFERROR(VLOOKUP([@IDFANGRAPHS],STEAMER_P, 
COLUMN(STEAMER_P[IP]),FALSE),0) 



How to Rank and Value Fantasy Baseball Players for Points Leagues   

Page | 77 
 

Step Description 

H: 

=IFERROR(VLOOKUP([@IDFANGRAPHS],STEAMER_P, 
COLUMN(STEAMER_P[H]),FALSE),0) 

ER: 

=IFERROR(VLOOKUP([@IDFANGRAPHS],STEAMER_P, 
COLUMN(STEAMER_P[ER]),FALSE),0) 

HR: 

=IFERROR(VLOOKUP([@IDFANGRAPHS],STEAMER_P, 
COLUMN(STEAMER_P[HR]),FALSE),0) 

SO: 

=IFERROR(VLOOKUP([@IDFANGRAPHS],STEAMER_P, 
COLUMN(STEAMER_P[SO]),FALSE),0) 

BB: 

=IFERROR(VLOOKUP([@IDFANGRAPHS],STEAMER_P, 
COLUMN(STEAMER_P[BB]),FALSE),0) 

FIP: 

=IFERROR(VLOOKUP([@IDFANGRAPHS],STEAMER_P, 
COLUMN(STEAMER_P[FIP]),FALSE),0) 

30. I don’t pull ERA or other easily calculable rate statistics (I will pull FIP), like 
WHIP, directly from the projections. I prefer to recalculate them with a formula 
after the underlying statistics have been pulled. 

To do this, type “ERA” in as the next column header. Then enter the formula to 
calculate ERA  (=([@ER]*9)/[@IP]). 
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Step Description 

If you're not exactly sure of the convention for the formulas (with the brackets 
and @ symbols) you can always use your mouse to click on the values in the 
"ER" and "IP" columns and Excel will translate it into the =(@ER]*9)/[@IP] 
format for you. 

Repeat this step to add WHIP and any other rate statistics you desire (K/9, 
K/BB, B/9, etc.). 

You might notice that these rate formulas can also result in errors if a player 
does not have a projection (dividing by 0 causes an error). You can use the 
IFERROR formula around the calculation to clean this up. 

Here are the formulas I use for ERA and WHIP: 

ERA: 

=IFERROR(([@ER]*9)/[@IP],0) 

WHIP: 

=IFERROR(([@BB]+[@H])/[@IP],0) 

31. Most statistics don’t need formatting, but ERA and WHIP will. In my file, ERA is 
located in column "Q". Click on the “Q” column label (or whatever column ERA 
is in for you) to select the entire ERA column. Then on the Home tab of the 
ribbon, click on the comma number format. 

 
Repeat this same step for WHIP (column R in my example file). 

32. Save the file. 

You’ve now successfully combined pitcher information and projected pitching 
stats into one table. 
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WRAP UP 

We have now completed setting up our hitter and pitcher worksheets that will 
be used to rank those players and we have also set up our league scoring 
settings. 

In the next part of the book we'll pull those scoring settings to the rankings 
sheets and calculate projected points for each player. 

DO YOU HAVE ANY QUESTIONS? 

Do you have questions about Part 4?  Or want to see what others have asked?  
Check here. 

EXAMPLE EXCEL FILE 

Download the example spreadsheet illustrating the work done in this part 
here.  Or you can download all spreadsheets for the entire book here.  

PART 5 – CALCULATING PROJECTED POINTS 
INTRODUCTION 

In this part of the book we will use the named cells created in Part 2 along with 
our projection information on the "Hitter Ranks" and "Pitcher Ranks" sheets 
to calculate total projected points for each hitter and pitcher. 

EXCEL FUNCTIONS AND FORMULAS IN THIS PART 

We'll just be doing some basic addition and multiplication.  We won't be 
adding in any new features, but we will be doing this basic math using the 
named cells for your league's scoring settings that we created in earlier parts of 
the book.  

http://www.smartfantasybaseball.com/2015/01/how-to-calculate-rankings-for-a-points-league-part-4-pitcher-rankings/%23comment-949
http://www.smartfantasybaseball.com/points4
http://www.smartfantasybaseball.com/jzv0
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To refresh your memory and to see the complete list of named cells, access the 
"Formulas" tab of the Ribbon and then click the "Name Manager" button. 

 

The list will display all named cells/ranges and named tables.  To view only 
named cells, click on the "Filter" drop down menu and choose "Defined 
Names". 
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STEP-BY-STEP INSTRUCTIONS 

Step Description 

1. Go to the "Hitter Ranks" tab in the Excel file. 

In the first open column next to the table data (e.g. cell  V1), type in "PROJ 
PTS" as the column header.  Excel should expand the table to include this new 
column. 

 
2. Recall from looking at our named cells above that we named our hitting point 

values using a "H_PTS_" prefix followed by the abbreviation for the stat 
category. 

In my example league, the hitting point values have the following names in 
Excel: 

• H_PTS_AB 
• H_PTS_H 
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• H_PTS_BB 
• H_PTS_2B 
• H_PTS_3B 
• H_PTS_HR 
• H_PTS_SB 

Follow the steps below using the scoring categories and named cells that you 
set up.  Follow these steps with your league in mind.  

We'll now use those names to build a formula to calculate projected points. 

In my example league, the first hitting scoring category is At Bats 
(H_PTS_AB). 

In the first empty cell below the "PROJ PTS" header (e.g. cell V2), type an "=" 
and then click on the corresponding stat for the player in this row. 

My first player is Bobby Abreu (wow!).  So I clicked in cell H2, the projected 
ABs for Abreu.  

 
3. While still editing this formula we've started, we must now multiply the 

projected AB for Bobby Abreu by the point value for AB. 

Type the sign for multiplication (the *, or SHIFT + 8).  Then begin to type 
"H_PTS_". 

 
Excel should recognize the name you're typing and present you with a list of 
named cells which follow that pattern.  Once you see this list you can double-
click on the desired name, use your arrow keys to select "H_PTS_AB" and hit 
TAB to choose it, or just continue typing the full name. 
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In my scoring system, I want "H_PTS_AB".  Hit enter to save the formula at 
this point. 

My completed formula at this point is: 

=[@AB]*H_PTS_AB 

You may need to use the "Number" format options on the "Home" tab of 
Excel's menu system to adjust the appearance of your points. 

 
4. Review the output of the "PROJ PTS" column at this point to make sure it 

seems to be working correctly. 
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The league I play in has an unusual scoring system that penalizes for outs 
(just like in real baseball, an out is a bad thing).  That's where the negative 
value for an AB comes in. 

5. Repeat steps 2, 3, and 4 above in order to add in the other hitting scoring 
categories of your league. Just begin at the end of your original "PROJ PTS" 
formula, add a "+" sign, and add in the next scoring category and point value. 

It may be a good idea to build the formula one stat category at a time so that 
you can do a quick reasonableness check. 

For example, building on the formula I started above, to add points for hits, I 
would edit my "PROJ PTS" formula to be: 

=[@AB]*H_PTS_AB+[@H]*H_PTS_H 

Continue until you have added in the points for each category. 

 
My final formula is: 

=[@AB]*H_PTS_AB+[@H]*H_PTS_H+[@BB]*H_PTS_BB+[@2B]*
H_PTS_2B+[@3B]*H_PTS_3B+[@HR]*H_PTS_HR+[@SB]*H_PT

S_SB 

 
6. The accountant in me really really wants you to double check the formula you 

just created. 

http://www.smartfantasybaseball.com/wp-content/uploads/2014/08/Final_H_Formula.png
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Make sure it seems consistent and that the [@AB] argument is paired with 
"H_PTS_AB", and all other categories align with their point value 
name).After all, it probably only took you a couple of minutes to create this 
formula.  It will probably only take another 30 seconds to review it 
closely...  And your WHOLE fantasy season depends on it! 

7. If the formula looks good, you can give it one more great check by sorting the 
"Hitter Ranks" tab by "PROJ PTS" to see who the best players are. 

To do this, click the downward pointing filter arrow on the "PROJ PTS" 
column.  Then click on "Sort Largest to Smallest". 

 
Hopefully you'll find that the players come out in an order that seems 
appropriate given your scoring system (does Mike Trout come out near the 
top?).   

 



How to Rank and Value Fantasy Baseball Players for Points Leagues   

Page | 86 
 

Step Description 

Now let's move on to the pitchers. 

8. Go to the "Pitcher Ranks" tab in the Excel file.  In the first open column next 
to the table data (e.g. cell S1), type in "PROJ PTS" as the column 
header.  Excel should expand to include this new row. 

 
Recall that we named our pitching point values using a "P_PTS_" prefix 
followed by the abbreviation for the stat category. 

In my example league, the pitching point values have the following names in 
Excel: 

• P_PTS_IP 
• P_PTS_K 
• P_PTS_BB 
• P_PTS_HA 
• P_PTS_SV 
• P_PTS_HD 
• P_PTS_HRA 

Follow the steps below using the scoring categories and named cells that you 
set up.  Follow these steps with your league in mind.  

9. Let's start to build a formula to calculate projected pitching points, starting 
with the first pitching point category. 

In my example, the first pitching category is Innings Pitched (P_PTS_IP).In 
the first empty cell in the "PROJ PTS" (e.g. S2), type an "=" and then click on 
the corresponding stat for the player in this row. 

My first player is David Aardsma (who at one point in time had fantasy-
relevance, so he made it into the PLAYERIDMAP). 

To include Aardsma's IP, I clicked in cell J2 (remember, your columns may be 
slightly different depending on when you and where you downloaded your 
projection data from). 



How to Rank and Value Fantasy Baseball Players for Points Leagues   

Page | 87 
 

Step Description 

 
10. While still editing this formula we've started, we must now multiply the 

projected IP for Aardsma by the point value for IP. 

Type the sign for multiplication (the *, or SHIFT + 8).  Then begin to type 
"P_PTS_". 

 
Excel should recognize the name you're typing and present you with a list of 
named cells which follow that pattern.  Once you see this list you can double-
click on the desired name, use your arrow keys to select "P_PTS_IP" and hit 
TAB to choose it, or just continue typing the full name. 

 
In my scoring system, I want "P_PTS_IP".  Hit enter to save the formula at 
this point. 

My completed formula at this point is: 

=[@IP]*P_PTS_IP 

You may need to use the “Number” format options on the “Home” tab of 
Excel’s menu system to adjust the appearance of your points. 



How to Rank and Value Fantasy Baseball Players for Points Leagues   

Page | 88 
 

Step Description 

 
11. Review the output of the "PROJ PTS" column at this point to make sure it 

seems to be working correctly. 

 
12. Repeat steps 9, 10, and 11 above in order to add in the other pitching scoring 

categories of your league. Just begin at the end of your original “PROJ PTS” 
formula, add a “+” sign, and add in the next scoring category and point value. 

It may be a good idea to build the formula one stat category at a time so that 
you can do a quick reasonableness check. 

For example, building on the formula I started above, to add points for strike 
outs, I edit my "PROJ PTS" formula to be: 

=[@IP]*P_PTS_IP+[@SO]*P_PTS_K 

Continue until you have added in the points for each category. 
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Step Description 

 
My final formula is: 

=[@IP]*P_PTS_IP+[@SO]*P_PTS_K+[@BB]*P_PTS_BB+[@H]*P
_PTS_HA+[@SV]*P_PTS_SV+[@HR]*P_PTS_HRA 

 
You might have noticed that my league's scoring system uses Holds as a 
pitching category but I've neglected to include that in my formula.  I have not 
been able to find a reliable projection system that projects Holds, so I've just 
ignored it. 

I have no research to back this up, but I feel I can largely ignore Holds during 
the draft.  By studying team depth charts and watching bullpen usage early in 
the season, I think I'll be able to identify unexpected sources of Holds during 
the season. 

13. The entire quality of your draft depends on this formula. 

Double check the consistency of your formula (check that the [@IP] argument 
is paired with "P_PTS_IP", and all other categories align with their point 
value name). 

14. If the formula looks good, you can give it one more great check by sorting the 
"Pitcher Ranks" tab by "PROJ PTS" to see who the best players are. 

To do this, click the downward pointing filter arrow on the "PROJ PTS" 
column.  Then click on "Sort Largest to Smallest". 

http://www.smartfantasybaseball.com/wp-content/uploads/2014/08/Final_P_PROJ_Formula.png
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Step Description 

 
Hopefully you'll find that the players come out in an order that seems 
appropriate given your scoring system (does Clayton Kershaw come out near 
the top?).   

 
15. Save your file. 

WRAP UP 

We now have total projected points for both hitters and pitchers, and you 
might be wondering, "What else is left to do?". 

In our next part of the book we'll add the important adjustment for 
replacement level. Failing to incorporate replacement level into your 
calculations can lead to some poor decisions. 
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DO YOU HAVE ANY QUESTIONS? 

Do you have questions about Part 5?  Or want to see what others have asked?  
Check here. 

EXAMPLE EXCEL FILE 

Download the example spreadsheet illustrating the work done in this part 
here.  Or you can download all spreadsheets for the entire book here.  

PART 6 – REPLACEMENT LEVEL AND POSITION 
SCARCITY 

INTRODUCTION 

In this part of the book we will discuss the concept of replacement level, prove 
that it can lead to better decision making, demonstrate how it is an objective 
measure for making positional scarcity adjustments, and then incorporate 
replacement level adjustments for each position into our projected point 
values. 

ACCOUNTING FOR REPLACEMENT LEVEL 

Heading in to the 2015 season, Ryan Braun is projected by Steamer to produce 
82 R, 25 HR, 82 RBI, and 13 SB (or 752 points in my example league).   Buster 
Posey is projected for 69 R, 19 HR, 75 RBI, and 1 SB (681 points). 

Braun's raw production is clearly superior to that of Posey.  But is that all we 
need to look at to conclude which player is more valuable?  Don't we need to 
include some measure of "replacement level" in this calculation?  Isn't that 
what WAR is all about?  Wins Above Replacement? 

How do I account for the fact that the day after our fantasy draft I can go out 
to the free agent listing and pick up an OF that would produce 61 R, 10 HR, 47 
RBI, and 15 SB (478 points), or a Catcher that would produce 38 R, 9 HR, 45 
RBI, and 7 SB (319 points)? 

Clearly the replacement catcher is much less productive than the replacement 
level OF. 

http://www.smartfantasybaseball.com/2015/01/how-to-calculate-rankings-for-a-points-league-part-5-calculating-projected-points/%23comment-973
http://www.smartfantasybaseball.com/points5
http://www.smartfantasybaseball.com/jzv0
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USING POINTS LEAGUE SETTINGS 

You've been following me through the creation of a rankings file for an 
example league. We just finished converting projected statistics into point 
values for this league, so let's take a look at comparing Braun to Alejandro De 
Aza (a hypothetical replacement level OF) and Posey to Christian 
Bethancourt (a hypothetical replacement level catcher). 

Player Projected Points 
Ryan Braun 752 
Alejandro De Aza 478 
Buster Posey 681 
Christian Bethancourt 319 

Braun is projected for 274 points over the replacement level outfielder and 
Posey is projected for 362 points more than the replacement level catcher! 

That means Posey is roughly 88 points more valuable than Braun, despite 
having lower overall projected points. 

If you're having a hard time digesting that, think of it this way.  Let's assume 
Braun and Posey represent second round draft picks (just go with it, don't 
argue) and De Aza and Bethancourt will be last round draft picks (replacement 
level). 

The team that takes Braun in the second round and Bethancourt in the last 
round would be projected for 1,071 points.  The team that takes Posey in the 
second round and De Aza in the last round would be projected for 1,159 
points.  Again, that's 88 more points than the 
Braun/Bethancourt combination! 

This is why considering replacement level matters. 

POSITIONAL SCARCITY ADJUSTMENTS 

You have probably come across suggestions or you might have even thought to 
yourself that you should "bump" a player up your rankings because he plays a 
weak position.  But is this really appropriate?  How much do you bump him 
up? 
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Another great benefit of incorporating replacement level into your rankings is 
that it makes your positional scarcity adjustments for you! 

You just saw how we proved Posey's 681 points as a catcher are more valuable 
than Braun's 752 from the outfield.  Rather than arbitrarily "bumping" Posey 
in the rankings, we can figure out exactly where he should be ranked by 
calculating his "Points Above Replacement". 

Let's look at the top 15 projected hitters in my example points league. 

 

Not a catcher to be found.  But if we presume this league has 24 starting 
catchers (you need to read this if you play in a two-catcher league), things 
change significantly when we calculate points above replacement. 

 

http://www.smartfantasybaseball.com/2014/03/two-catcher-league-draft-strategy/
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Three catchers rocket into the top 10 while OF and 1B are devalued some.  This 
movement that takes place after you calculate Points Over Replacement Level 
IS THE POSITIONAL SCARCITY ADJUSTMENT.  Players move exactly 
the proper amount.  No guesswork. 

EXCEL FUNCTIONS AND FORMULAS IN THIS POST 

Nothing really new here.  We'll just be using things we've already used in 
earlier parts of the book.  We will use another VLOOKUP formula, create a 
table, and use structured references to build some formulas. 
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STEP-BY-STEP INSTRUCTIONS 

Step Description 
1. On the "Scoring Settings" sheet, begin to fill out the information you see in 

columns G and H below. 

 
2. Click and drag with your mouse to select the area of the table you have started 

(ignore the "Replacement Level" heading). 

 
On the "Home" tab of the Ribbon, select the "Format as Table" drop down and 
choose a color scheme. 
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Step Description 

 
Make sure to specify that your table has headers (check the box). And hit OK. 

 
3. Just like with all our other tables, we should give this a name. On the 

"Formulas" tab of the Ribbon, click on "Name Manager". 
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Step Description 
When Name Manager appears, choose to Filter the list by "Table Names". 

 
Locate the only unnamed table (mine is "Table4" in the example below).  Click 
on the table in the list and then hit the "Edit..." button. 

 
Change the name of this to "REPLACEMENT_LEVEL" and hit "OK" to save 
the name.  Then hit "Close" to exit the "Name Manager". 
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Step Description 

 
4. Return to the “Hitter Ranks” tab.   

 
Use the drop down arrow on the “PROJ PTS” column to ensure it is sorted in 
descending order (players with most projected points at the top).   

 
Now click on the downward pointing arrow on the “POS” column. Click/toggle 
the "Select All" box until all selections are cleared (none are checked).  Then 
click to select only the “C” position.  Click “OK” to accept this filter. 
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Step Description 

 
5. Consider your league size and roster rules and develop an approximation of 

how many catchers will likely be drafted. 

For example, in a 12-team league in which each team starts two catchers, 
there likely won’t be any catchers starting at the DH/UTIL spot.  This means 
that 24 catchers will be drafted. 

To determine who the replacement level catcher will be, click once on the 
"PROJ PTS" value of the first catcher (Posey in my example).   
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Step Description 
Then click and drag to select more players (you can see an image of this 
below, make sure you are highlighting only one column). 

 
As you continue to select more players, watch the “Count:” field on the Excel 
status bar. 

 
6. Stop highlighting when the count of catchers reaches the number you expect 

to be drafted (e.g. 24). 

The replacement level player is the very next player that falls outside of the 
top 24.In the screenshot below you can see that the first catcher not to be 
drafted will be Rene Rivera.  His projected points are 284. 
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Step Description 

 
7. Return to the "Scoring Settings" sheet.   

 
And type in the projected points for the replacement level catcher into our 
"REPLACEMENT_LEVEL" table created earlier (e.g. 284 for Rene Rivera). 
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Step Description 
8. Repeat steps 4 - 7 for each position. 

If your league has Corner Infield and Middle Infield roster spots, determining 
replacement level for the infield positions involves some additional work. 

The easiest method (it's a little imprecise) would be to assume 18 1B will be 
drafted and 18 3B will be drafted (12 1B to play the 1B slot, 6 1B to play CI, 12 
3B to play 3B slot, and 6 3B to play CI). 

 
If you want to be more precise, set your filters to show both 1B and 3B at the 
same time. 

Then click and drag so you can see the count of the 36 top combined 1B and 
3B. 

Then manually count to verify there are at least 12 1B and 12 3B (to fill the 
actual 1B and 3B positions). 

 

 
As long as you have at least 12 1B and 12 3B, nothing else is necessary.  If you 
don't have at least 12 3B, take one 1B out of your group and add in the next 
best 3B. 

For example, when I ran through my hypothetical league I found that the top 
36 corner infielders were made up of 22 1B and 14 3B. 
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Step Description 
The very next first basemen and the very next third basemen outside of that 
top 36 are your replacement level players. 

You must follow a similar process to account for the UTIL/DH spot in your 
roster.  This will push replacement level even further down the list of players. 

The UTIL/DH slot is likely going to end up changing who the last 1B and OF 
are.  Instead of drafting the top 22 1B (in my example), my league will also 
likely draft even more 1B to put at the UTIL/DH spot. 

NOTE:  Explaining how to identify replacement level in writing is very 
difficult.  It's probably even harder for you to understand my scattered 
thoughts. 

That's why I created this video to show a practical approach you can use.  The 
video is using "Standings Gain Points" instead of "Projected Points", but the 
exact same approach can be followed.  If you do follow the approach in the 
video you'll have a very easy to understand color-coded result letting you 
know exactly who the replacement level players are. 

 
In the end, you must verify that your projected pool of draftable players 
satisfies your league's roster requirements.  If you are in a 12-team league with 
traditional roster requirements (where each team drafts 14 hitters), select the 
top 168 players and verify that at least 24 C, 36 CI, 36 MI, and 60 OF are 
included. 

Provided these limits are met, the replacement level points for each position is 
very next 1B, 2B, SS, 3B, or OF that fall outside of your pool of draftable 
players. 

REPLACEMENT LEVEL FOR THE UTIL SPOT:  Your UTIL slot is likely 
to be filled by a variety of positions (1B, 2B, OF, etc.). Because it can be filled 
by a player of any position, I believe you should make the replacement level 
points for DH/UTIL equal to the position with the highest replacement level 
(this is covered in the video too). 

https://www.youtube.com/watch?v=j0ztlMHwPiU


How to Rank and Value Fantasy Baseball Players for Points Leagues   

Page | 104 
 

Step Description 
9. Follow steps 4-7 to determine replacement level for pitchers.  This should be 

much simpler because even if your league uses specific "SP" and "RP" spots, 
you don't need to determine replacement level for these differently unless 
your league has a very unique configuration that forces you into drafting relief 
pitchers to fill spots. 

After you have identified all your replacement level players, make sure you've 
filled out the entire REPLACEMENT_LEVEL table. 

 
10. Let's focus just on hitters for a few steps. 

We now need to adjust each player's projected points to reflect their points 
above replacement level (like we did above in our Braun vs. Posey example). 

Go to your "HITTER RANKS" tab.  Make sure you have cleared any position 
filters.  To do this, click once on a piece of data in the "HITTER RANKS" 
tab.  Then go to the "Data" tab and click the "Clear" button. 

 
Now add a new column header next to your "PROJ PTS" column. This is 
where we will pull in the Replacement Level points for each player. 

Column W is the first unused column in my example file.  So click in cell W1, 
type "REPL LEVEL", and hit Enter. 
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Step Description 

 
11. To populate this "REPL LEVEL" column we want Excel to look at each 

player's position, go find that position in the replacement level table we just 
set up on the "Scoring Settings" tab, and bring back the replacement level 
point value for that position. 

We can do this using a VLOOKUP formula. 

Recall that the VLOOKUP formula is used to search in another table for a 
specific value (look in the replacement level information and find a specific 
position). 

The formula to use for the VLOOKUP in cell W2 is: 

=VLOOKUP([@POS],REPLACEMENT_LEVEL,2,FALSE) 

You might be wondering why I typed a "2" in for the Col_index_num. 

The reason is because the REPLACEMENT_LEVEL table does not start in 
Column A, like all our other tables have to this point.  The formula 
"COLUMN(REPLACEMENT_LEVEL[POINTS])" returns an 8 because it's in 
column H of my "Scoring Settings" tab.   
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Step Description 

 
Review the output of the formula.  An easy way to see if everything is working 
properly is to look for a catcher in the list and verify the point value is 
consistent with your results from step 7 above. 

 
12. Now let's add a column to calculate points above replacement level for each 

player.  My first empty column in my example file is column "X".  So in cell 
X1, I'll type "POINTS OVER REPL" as the column header and hit Enter. 
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Step Description 

 
The formula here will simply be: 

=[@[PROJ PTS]]-[@[REPL LEVEL]] 

Type the equals sign and then use your mouse to click on the "PROJ PTS" and 
"REPL LEVEL" columns as needed while building the formula. 

13. As we looked at in the introduction to this part, it's possible that player 
rankings (especially for catchers) can shift after you take replacement level 
into account. Sort the "POINTS OVER REPL" column by clicking on the 
downward pointing triangle over the column.  Then select "Sort Largest to 
Smallest". 

 
14. The POINTS OVER REPL column becomes very important if we are to 

eventually calculate dollar values for players.  It's important that this column 
show 0 for the replacement level players in your league. 

YOU NEED TO CHECK THIS. 

Recall that my example spreadsheet is being built for a 12-team league where 
each team drafts 14 hitters.  That would be 168 hitters drafted in total. 
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Step Description 
You can see in my example below that as I approach the 168th player and 
move into the replacement level players the "POINTS OVER REPL" approach 
zero.  You should see this same thing!  As you approach the last few drafted 
players the "POINTS OVER REPL" should approach zero. 

 
If you don't see this type of result, you need to reevaluate replacement level 
and make adjustments to the "REPLACEMENT LEVEL" table on the "Scoring 
Settings" tab. 

15. Repeat steps 10 - 14 for pitchers. 

In a 12-team league that rosters 9 pitchers, 108 starting pitchers will be 
drafted, leaving the 109th pitcher as "replacement level". 

Adjust this for your own league's settings. 

Even if your league has different spots for Starting Pitchers and Relief 
Pitchers, I do not recommend determining replacement level for RP and SP. 

Make sure you perform the same check of your pitchers.  As you approach 
replacement level, the "POINTS OVER REPL" should move towards 0.  As you 
move below replacement level, you should see the points go negative. 

16. Save your file.  You have now completed your points league hitter and pitcher 
rankings! 
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WRAP UP 

We have calculated the points over replacement level for each player.  You no 
longer have to make arbitrary decisions because you're trying to account for 
"positional scarcity".  The points over replacement level factors this in.  It's not 
as simply as comparing the points over replacement level for a catcher and 
comparing them to an outfielder. 

DO YOU HAVE ANY QUESTIONS? 

If you have questions about Part 6, it would be great if you can ask them here. 

EXAMPLE EXCEL FILE 

Download the example spreadsheet illustrating the work done in this part 
here.  Or you can download all spreadsheets for the entire book here.  

PART 7 – DOLLAR VALUE CALCULATION SETTINGS 
INTRODUCTION 

In this part of the book we will begin taking steps toward converting players' 
point totals into dollar values.  Specifically, we'll be adding some settings 
information about how the dollar values will be calculated.  We will set these 
up in such a way so you can easily tailor the dollar values for any size league. 

EXCEL FUNCTIONS AND CONCEPTS IN THIS POST 

"COMPARTMENTALIZING" COMPLEX EQUATIONS 

The process of converting a point total for each player to a dollar value is 
not overly complex.  At a very high level, we will: 

• Determine the total number of points that we expect to be drafted 
• Determine the total pool of dollars the league has to spend on these 

points 
• Calculate “dollar value per point” based on the information above 
• Multiply each player’s projected point total by the “dollar value per 

point” 

http://www.smartfantasybaseball.com/2015/02/how-to-calculate-rankings-for-a-points-league-part-6-replacement-level-and-position-scarcity/%23comment-974
http://www.smartfantasybaseball.com/points6
http://www.smartfantasybaseball.com/jzv0
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That’s not terribly difficult to do in one formula.  The dollar value 
calculation for a player might look like this: 

=(12*260)/(SUM(‘Pitcher Ranks’!$U$2:$U$109)+SUM(‘Hitter 
Ranks’!$X$2:$X$169))*[@[POINTS OVER REPL]] 

That gets the job done, I suppose.  But it becomes much more difficult to 
adjust if your league goes to 10 or 14 teams next year, if the budget changes, 
or if they decide to draft 25 players instead of 24.  This also doesn’t account 
for the commonly used rule that each player must cost at least $1. 

Instead of jamming all the pieces of this calculation into one formula, I 
prefer to break things apart into more manageable and easy-to-update 
pieces.  You can already see examples of this on the “Scoring Settings” tab 
where we have separated out the point value of each scoring category. 

USING CELL SHADING TO INDICATE MEANING 

As you are building more involved calculations with multiple steps, it is to 
indicate which cells in your spreadsheets are “input” cells and which ones 
are “calculated” (formula) cells. I like to denote this by shading the cells a 
certain color. 

 

A simple example of this is determining your "League Budget" or the total 
amount of money to be allocated for player dollar values.  For example, if 
you assume each team has a standard $260 budget, that would be $2,600 
for a 10-team league or $3,120 for a 12-team league. 

An example of how this will look is shown above.  The information shaded 
blue are "inputs" into the "calculated" cell which is shaded light red. 

Color coding in this fashion allows you to easily come back later and know 
exactly where to make changes.  You'll know that you can freely make 
changes to the blue shaded cells and that you don't need to change the red 
shaded cells. 

http://www.smartfantasybaseball.com/wp-content/uploads/2015/01/LEAGUE_BUDGET.png
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Not to mention that all these fancy colors are going to intimidate the guy 
sitting next to you at the draft table. 

NAMED CELLS (OR NAMED RANGES) 

We previously used Named Cells when setting up your league's scoring 
system in Part 2.  We'll use that same concept more to set up the league's 
dollar value calculation settings. 

STEP-BY-STEP INSTRUCTIONS 

Step Description 
1. Go to the "Scoring Settings" tab of the spreadsheet. 

2.  Begin to fill out column J by entering the following information: 

 
3. To use the concept of cell shading discussed above, I'll first place a boarder 

around the cells to be shaded. 

Click once on the first cell to be formatted (K1) and select the "Borders" drop 
down menu on the Ribbon.  Then choose the "Outside Borders" option. 
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Step Description 

 
4. This "Number of Teams:" cell will be an input cell that we type "12" or "14" into 

(or however many teams are actually in your league).  While you are still 
selected on cell K1, click the "Fill Color" drop down arrow and select the same 
color you used earlier in Part 2 to indicate "input" cells. 

 
5. The other input cells will be in cells K2, K5, and K6.  To quickly format them 

the same as cell K1, while you are still selected on cell K1, double-click on the 
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Step Description 
"Format Painter" icon.  While "Format Painter" is activated like this, any cell 
you click on will format to the same way as cell K1. 

  

6. While "Format Painter" is active (you can tell it's active when you see the paint 
brush next to your cursor and rotating dashed line around cell K1), simply click 
once on cells K2, K5, and K6.After you are done using "Format Painter", hit the 
ESC key to exit. 

 
7. Cell K3 will be a "calculated cell".  Follow steps 3 and 4 above to give the cell a 

border and assign it a fill color.  Make sure to choose a different color than 
you chose for your "input cells". 
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Step Description 

 

8. While you have cell K3 selected, double-click on the "Format Painter" and 
then click once on cells K8 and K9.  Hit the ESC key afterwards to exit 
"Format Painter". 

 
9. Let's now enter in some of this information.  Type the number of teams in your 

league into cell K1 (e.g. 12).Enter each team's budget into cell K2 (e.g. $260). 
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Step Description 

 

10. To calculate the total amount of money your league has for spending on players, 
enter the following formula in cell K3 and then hit Enter: 

= K1 * K2 

 

11. Enter the number of hitters each team will draft in cell K5 (e.g. 14) and the 
number of pitchers each team will draft in cell K6 (e.g. 9). 

If your league has bench spots available, using opposing manager tendencies 
from previous seasons make an estimate of how those bench spots will be 
used.  Then allocate those bench spots to the "Number of Hitters Drafted Per 
Team" and the "Number of Pitchers Drafted Per Team" fields. 

For example, if your league calls for 14 starting hitters, 9 starting pitchers, and 
5 bench spots, that would be 28 total players.  If you think most teams will end 
up using the bench for 3 hitters and 2 more pitches, enter 17 for hitters and 11 
for pitchers. 

Just make sure the total hitters and pitchers is equal to the number of players 
each team can draft. 

 



How to Rank and Value Fantasy Baseball Players for Points Leagues   

Page | 116 
 

Step Description 
12. To calculate the "Total Hitters Drafted", enter the following formula in cell K8 

and hit Enter: 

= K1 * K5 

 

13. To calculate the "Total Pitchers Drafted", enter the following formula in cell K9 
and hit Enter: 

= K1 * K6 

 

14. In order to convert out point values into dollar values we will need to reference 
and use the following pieces of information in future formulas: 

• Total League Budget (cell K2) 
• Total Hitters Drafted (cell K8) 
• Total Pitchers Drafted (cell K9) 
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Step Description 

Like we did earlier in Part 2 with the League Scoring Settings, to make these 
cells easier to reuse in formulas, we will set them up as "Named Ranges". 

To do this, first click on cell K3, "Total League Budget".  Feel free to use our 
same method of naming this cell.  But a faster way to name cells is to use the 
"Name Box".  It's the area to the left of the formula bar and below the "File" and 
"Home" tabs of the ribbon.  While you are selected on cell K3 the "Name Box" 
should display "K3". 

 

Use the "Define Name" button (old way of naming cells) or the "Name Box" to 
name cell K3 "League_Budget". 

 

15. Repeat step 14 giving the following names: 

• "TOTAL_HITTERS_DRAFTED" - cell K8 
• "TOTAL PITCHERS DRAFTED" - cell K9 

16. Remember, if you need to edit a Named Range or just want to double check the 
list of names you have created, just click on the "Formulas" tab and then the 
"Name Manager". 
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Step Description 

 

Once you're in "Name Manager" you will see the list of all names and all 
tables.  Select the item you want to rename or change and click "Edit...". 

 

WRAP UP 

You have just completed the setup of your league's dollar settings.  This 
ground work will help us convert projected point totals into dollar values. 
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DO YOU HAVE ANY QUESTIONS? 

Do you have questions about Part 7?  Or want to see what others have asked?  
Check here. 

EXAMPLE EXCEL FILE 

Download the example spreadsheet illustrating the work done in this part 
here.  Or you can download all spreadsheets for the entire book here.  

PART 8 – CONVERTING POINTS INTO DOLLAR VALUES 
INTRODUCTION 

If you think about what information is necessary to value a player, we need 
these things: 

• The number of players that will be drafted 
• The amount of money available for spending 
• A measure of how good each player is 

In the first six parts of this book we calculated projected points for all hitters 
and pitchers.  That is our measure of how good each player is.  In our last part 
of this book we determined the first two bullet points. 

We can now begin to convert all this information into a dollar value for each 
player. 

CALCULATING VALUES 

In the example file I've been using to demonstrate this process, we know that 
we have $3,120 ($260 for 12 teams) to allocate to 276 players (168 hitters and 
108 pitchers). 

We haven't calculated this yet, but let's assume that these 276 players are 
projected for a total of 37,002 points over replacement level (24,188 for hitters 
and 12,814 for pitchers). 

You might be thinking that we could just divide the $3,120 by the 37,002 
points to find out that each point over replacement level is worth 
$0.0843.  Under that calculation a player like Mike Trout, projected for 508 
points over replacement level, would be worth $42.83. 

http://www.smartfantasybaseball.com/how-to-rank-and-value-players-in-a-points-league-part-7/%23comment-978
http://www.smartfantasybaseball.com/points7
http://www.smartfantasybaseball.com/jzv0
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That's a good line of thinking, but we need to account for one more rule.  Most 
leagues stipulate that a minimum bid on a player is $1. 

We can easily adjust for this.  Instead of assuming we have $3,120 to divide 
against the 37,002 points, we'll first take out a $1 minimum for each of the 276 
players.  This leaves us with $2,844 for the same 37,002 points. 

Adjusting for these new figures, each point over replacement level is worth 
$0.07686. Our new value formula for any player is: 

= Points_Over_Replacement_Level * $0.07686 + $1 

EXCEL FUNCTIONS AND CONCEPTS IN THIS PART 

 RANK OR RANK.EQ 

These formulas are essentially the same; however, RANK was been 
discontinued in Excel 2010 and was replaced by RANK.EQ. If you are using 
Excel 2007 or earlier, you must use RANK. If you’re using Excel 2010 or 
later, either one should work. 

These formulas will interpret a list of numbers and return the ranking of a 
specified item in the list. We can use this to analyze the entire list of player 
points and give us a ranking for each player (e.g. Mike Trout is #1). 

The formulas require two inputs: 

RANK(Number, Ref) 

RANK.EQ(Number, Ref) 

1. Number – This is the specific number you want ranked. If your goal is to 
figure out Mike Trout’s ranking in the list of all player projected points, 
you would select Mike Trout’s projected total. 

2. Ref – This is the range of data, or the complete list of data, to calculate 
the ranking from. Continuing with the Trout example, you would pick the 
entire column of hitter projected points here. 
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IF 

The IF formula checks to see if a condition you specify is met. If the 
condition is met, the formula will return an answer of your choosing. If the 
condition is not met, the formula will return a different answer of your 
choosing. 

Recall from our examples that we will be drafting 168 hitters. We will use 
this formula to treat the 168 draftable hitters one way and anyone not in the 
top 168 another way. 

This formula requires three inputs: 

IF ( Logical_test, Value_if_true, Value_if_false) 

1. Logical_test – This must be a statement that can be determined to be 
true or false. An example might be “Is this player ranked in the top 168 
players?”. 

2. Value_if_true – If the Logical_test is determined to be true, this is the 
value returned by the formula. 

3. Value_if_false – If the Logical_test is determined to be false, this is the 
value returned by the formula. 

SUM 

The SUM formula will calculate the total of a range of cells. For example, 
we can calculate the combined amount of projected points in the “POINTS 
OVER REPL” column or the projected number of Home Runs by using 
“SUM” on the “HR” column. 

This formula requires just one input: 

SUM (Range) 

Range – This is the range of cells to include in the calculation. 
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STEP-BY-STEP INSTRUCTIONS 

Step Description 
1. Our first task in this segment is to identify who the top 168 hitters and the top 108 

pitchers are (keep in mind the 168/108 numbers are specific to my example, if your 
league drafts 182 hitters and 132 pitchers, use those numbers in your spreadsheet). 

We need this to calculate the total points that we expect to be drafted.  We will use 
that expected point total to calculate our "Dollar Value per Point" that we can then 
use to calculate a projected value for each player. 

Go to the "Hitter Ranks" tab of your spreadsheet. Start a new column by typing 
"RANK" just to the right of your "POINTS OVER REPL" column (in my example 
scenario I typed this into cell Y1). 

 

2. We will now use the RANK formula to determine if a player falls in the top 168 
hitters. To do this, enter the following formula below the "RANK" header we just 
created (cell Y2 in my example): 

=RANK([@[POINTS OVER REPL]],[POINTS OVER REPL]) 

This is instructing Excel to rank each player's "POINTS OVER REPL" (the one with 
the "@" symbol means look at this player's points) in the entire list of the "POINTS 
OVER REPL" column (that's the second input into the formula, after the comma). 

After you hit Enter to apply the formula you should see that each player is now 
ranked. 

 

3. Remember that we are trying to determine the POINTS OVER REPL for the top 
168 hitters and top 108 pitchers.  If a hitter is in the top 168, we want that player's 
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Step Description 
POINTS OVER REPL to be included in a new column that we can easily use to 
calculate the total POINTS OVER REPL for the whole group of the top 168 hitters. 

The top 168 hitters will be "useful" or "draftable".  Type "USEFUL PTS" into cell 
Z1 to start this new column. 

 

4. We'll now use the IF formula to determine if an individual player is within the 
draftable pool of players (the top 168). If a player is draftable, we want their 
POINTS OVER REPL to carry over into column Z. If a player is not draftable, we 
do not want their POINTS OVER REPL included in the column, we just want a 
zero to display for those players. 

To accomplish this, enter the following formula in cell Z2: 

=IF([@RANK]<=TOTAL_HITTERS_DRAFTED, 
[@[POINTS OVER REPL]],0) 

 

We created the "TOTAL_HITTERS_DRAFTED" column in Part 7 to calculate the 
total number of usable or draftable hitters. 

In plain English, this formula is saying, "If the hitter's rank is 168 or below, give 
me that player's POINTS OVER REPL. If the hitter's rank is 169 or above, just put 
a zero." 

5. To verify the formula is working correctly, scroll to the 168th ranked hitter. You 
should see that all players ranked 169 and higher have 0 points in the USEFUL 
PTS column. 
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Step Description 

 

6. Repeat steps 1 through 5 on the "Pitcher Ranks" tab. Everything should be the 
same except the formula in step 4 changes to become: 

=IF([@RANK]<=TOTAL_PITCHERS_DRAFTED, 
[@[POINTS OVER REPL]],0) 

Make sure you perform the review in step 5 to verify your formulas are working 
properly. The 109th pitcher should show a 0 in the USEFUL PTS column. 

 

7. Now return to the "Scoring Settings" tab.  Enter the descriptions shown in the 
image below in cells J11 through J13. 
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Step Description 

 

8. These will be calculated cells.  To format them consistently with our other 
calculated cells, select cell K9. While K9 is selected, double-click on the Format 
Painter (on the Home tab of the ribbon). 

 

Then click once on cells K11, K12, and K13.  Hit the ESC key afterwards to exit the 
Format Painter. 

 

9. To calculate the "Draftable Hitter Points:" amount, enter the following formula in 
cell K11 and hit Enter: 

=SUM(MYRANKS_H[USEFUL PTS]) 

This formula will calculate the sum of the "USEFUL PTS" column in the 
"MYRANKS_H" table. 
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Step Description 

 

10. To calculate the "Draftable Pitcher Points:" amount, enter the following formula 
in cell K12 and hit Enter: 

=SUM(MYRANKS_P[USEFUL PTS]) 

This formula will calculate the sum of the "USEFUL PTS" column in the 
"MYRANKS_P" table. 

 

11. The "Total Draftable Points:" cell will simply be the sum of "Draftable Hitter 
Points" and "Draftable Pitcher Points". 

Enter the following formula in cell K13 and hit Enter: 

=K11+K12 

 

12. These three cell should have a comma in the number.  Your example may be 
slightly different.  But if you are having formatting issues with the numbers, use 
the number format buttons in Excel to get your desired appearance. 
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Step Description 

 

I chose the comma and then hit the decrease decimal button two times to remove 
the decimal places. 

 

13. We are now ready to calculate just how much each point will be worth in our value 
formula. 

Enter the descriptions shown in the image below in cells J15 and J16. 

 

14. These two new amounts will also be calculated cells.  To format them consistently 
with our other calculated cells, select cell K9 again. While K9 is selected, double-
click on the Format Painter (on the Home tab of the ribbon). 
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Step Description 

 

Then click once on cells K15 and K16.  Hit the ESC key afterwards to exit the 
Format Painter. 

 

15. Recall from the beginning of this section that we must set aside a $1 base value for 
each player. This money must be removed from the pool we will use to calculate 
"Dollar Value Per Point". 

To do this, enter the following formula in cell K15 and hit Enter: 

=LEAGUE_BUDGET-TOTAL_HITTERS_DRAFTED-
TOTAL_PITCHERS_DRAFTED 

 

This is essentially K3 minus K8 minus K9 but we previously set those cells up as 
Named Cells.  I find it easier to make sense of formulas later on if I use their names. 
I won't give a name to every cell on this tab, but if I think I'll refer to a tab more 
than once or if I'll refer to it on another tab, I try to use names. 
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Step Description 
Remember, your projected points will surely differ from mine based on the 
projections you're using and your league's scoring format. 

 

Again, use the number formatting buttons to give this value a dollar sign and 
remove the decimal places. 

16. Now it's time to calculate the dollar value of each point over replacement level! To 
calculate this, enter the following formula in cell K16 and hit Enter: 

=K15/K13 

 

Because my calculation results in so many decimals, I formatted this cell to have a 
dollar sign and then I increased the decimals several places. 

17. We will reuse this "Dollar Value Per Point" amount on the "Hitter Ranks" and 
"Pitcher Ranks" to calculate each player's dollar value, so it will be beneficial to set 
this up as another "Named Cell". 

Click once on cell K16 to select it.  Then click in the "Name Box" (this is the faster 
method of naming a cell discussed in Part 7).Type in the name for this cell as 
"DOLLAR_VALUE_PER_POINT" and hit Enter. 



How to Rank and Value Fantasy Baseball Players for Points Leagues   

Page | 130 
 

Step Description 

 

18. Now return to the "Hitter Ranks" tab. 

While the "USEFUL PTS" column is necessary to calculate dollar values, it is of 
little value to us to actually look at the information in the column after it's been set 
up. 

To hide this column, right-click on the "Z" column header and select "Hide" from 
the right-click menu. 

 

19. Start a new column in the table by typing "$VALUE" into cell AA1. 
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Step Description 

 

20. It's finally time to calculate each player's dollar value! 

To calculate this, enter the following formula in cell AA2 and hit Enter: 

=[@[POINTS OVER REPL]]*DOLLAR_VALUE_PER_POINT+1 

 

This is the formula we discussed at the beginning of this entire Part. We are taking 
each player's projected points over replacement level (NOT USEFUL POINTS!) 
and multiplying it by the named cell "DOLLAR_VALUE_PER_POINT" that we 
just created.  We then add the $1 base price we much have for each player. 

You should now see dollar values populating for each player (you will probably 
have to use the currency format button on the toolbar to format the numbers with 
dollar signs and two decimal places). 

 

21. Repeat steps 18, 19, and 20 on the "Pitcher Ranks" tab. The new "$VALUE" column 
is column X in my example file. 
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Step Description 

 

22. The final task in this process is to perform a check of your dollar values at this 
time.  This is VERY IMPORTANT. We can very easily tell if a mistake was made 
somewhere along the way. 

We will check this by making sure the combined dollar value of all draftable players 
is the same as the "Total League Budget" on the "Scoring Settings" tab. 

Click on the first dollar value of the "Hitter Ranks" tab in cell AA2. Then click and 
drag to select all the items in the $VALUE column until you get to your last 
draftable hitter (in my league it's hitter #168 or row #169). 

You should see the $VALUE amounts approach $1 as you get to the replacement 
level players. 

 

Then look at the "Sum" in the Excel status bar (along the bottom of Excel). 

 

Jot this number down. 

23. Now go to the "Pitcher Ranks" tab and repeat step 22.  For my pitchers I'm 
capturing the sum of the top 108 pitchers (up to row #109 in my spreadsheet). 
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Step Description 

 

 

24. Now add your total draftable hitter dollar value to the total draftable pitcher dollar 
values: 

Draftable Hitter Dollar Value: $2,027.11 

Draftable Pitcher Dollar Value:  $1,092.89 

Total: $3,120.00 

This agrees exactly to my "Total League Budget" so I can be confident that I've 
done things correctly. 

 

WRAP UP 

You did it!  You have taken a blank Excel file and converted it into a powerful 
tool to give you an advantage in your leagues for seasons to come.  You can use 
this to make decisions about free agent acquisitions, trade offers, and more. 
This spreadsheet you just created contains projections, rankings, position 
scarcity adjustments, and dollar value conversions. How many people in your 
league are coming to the draft with your level of preparation? 
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This tool is all formula based and will update in real-time. That's fancy 
technology speak for saying you can edit or paste in new projection data and 
with a few tweaks (e.g. you probably should look at replacement level again 
after making significant adjustments) you will have updated rankings and 
dollar values. 

The next part in the book is not required but is helpful for monitoring in-draft 
spending trends that could affect dollar values during the draft and for keeper 
leagues that need to account for price inflation due to kept players heading 
into the draft. 

DISCLAIMER 

I may take the phrase “replacement level” too literally.  If you think back to 
part 6 of this book, I suggested you define the replacement level player as the 
first undrafted player at each position.  Using this definition of “replacement 
level” gives these undrafted players a value of $1, whereas many would argue 
the last players drafted should be valued at $1.   

If you would like for your last players drafted at each position to be valued at 
$1, move your definition of replacement level up one player to the last player 
drafted.  For example, instead of the 25th catcher you would use the 24th 
catcher’s projected point total as your replacement level catcher. 

This small change can cause player dollar values to shift by a couple of dollars 
for players at the top. 

DO YOU HAVE ANY QUESTIONS? 

Do you have questions about Part 8?  Or want to see what others have asked?  
Check here. 

EXAMPLE EXCEL FILE 

Download the example spreadsheet illustrating the work done in this part 
here.  Or you can download all spreadsheets for the entire book here.  

http://www.smartfantasybaseball.com/how-to-rank-and-value-players-in-a-points-league-part-8/%23comment-977
http://www.smartfantasybaseball.com/points8
http://www.smartfantasybaseball.com/jzv0
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PART 9 – INCORPORATING IN-DRAFT AND KEEPER 
LEAGUE INFLATION 

INTRODUCTION 

In this section we’ll discuss the concept of inflation, both for “in-draft” 
inflation and for keeper leagues.  Then we’ll add more calculations to the 
spreadsheet we’ve created to incorporate an inflation calculation. 

I believe this is the most difficult chapter in the book.  Not only do the fantasy 
baseball concepts, like inflation, become more difficult, but that means the 
Excel formulas used calculate these things become more complicated as well.   

I don’t say that to scare you. Only to warn you not to let up yet! 

Let’s assume you’re in an auction draft and you have calculated point values 
and dollar values customized to the settings of the league. When you’re done 
with your calculations you believe the top players, like Mike Trout and Clayton 
Kershaw, should go for $35-$40 in the auction.  But when the auction rolls 
round you see something completely different.  Those players are going to 
$45-$50! 

Or let’s assume another scenario.  This time you’re in a keeper league where a 
player can be kept for multiple seasons.  Any player that is kept is done so at 
the price they went for in the previous year’s auction plus $5 for each year they 
are kept.  In a league like this it would not be inconceivable that someone 
could have Mike Trout at $20 or less heading in to the 2015 season.  

How do we account for these two scenarios?  In one league players are being 
auctioned for much more than we think they “should” be.  This means there 
will be less money for teams to spend on the remaining players.  In the other 
league players are being kept at significant discounts.  This means there will be 
more money for teams to spend on the remaining players. 
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RECALCULATING DOLLARS PER POINT 

Recall from part 8 that our example 12-team league has a total budget of 
$3,120.  You’ll also remember that we calculated the total points over 
replacement level of draftable hitters and draftable pitchers (37,002 points in 
my example).  We used this league budget and useful points to calculate the 
price of one point ($0.7686 / point). 

This calculation can be modified to include the effects of kept/drafted players 
by: 

1. Reducing the pool of available money (all of the $3,120 is no longer 
available) 

2. Reducing the pool of available useful points (some of the 37,002 points 
have been drafted) 

Once we have revised dollar amounts and a revised pool of useful points, we 
can reperform our dollar value calculations with these new inputs. 

BELOW REPLACEMENT LEVEL PLAYERS 

Alright, so we have to develop a way to track how many of the original $3,120 
and 37,002 points are still available.  Not too difficult.  But here’s another 
wrinkle we need to take in to account…   

What are the odds that your top 168 hitters will be the same top 168 hitters of 
everyone else in your league?  Just about impossible, right?  Some pour soul is 
going to draft an injured player or pay way too much for a rookie that won’t be 
called up until July.   

This presents an interesting challenge because what do we do if someone in 
the league spends $10 on a player that you have as being outside the pool of 
useful players?  

This is great for you.  Not only does this increase the likelihood that you’re 
going to get a better player (because they used up a roster spot on someone 
you wouldn’t even draft), but it also means there is less money you need to 
compete against for the rest of the auction. 

We need to account for this scenario in our dollar value calculations.   
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The following example wouldn’t happen, but it should help illustrate the 
changes we need to make.   

Assume the first two players auctioned off are the 1st and 2nd ranked hitters for 
$45 and $40, respectively. Then the 3rd player auctioned off is the 175th ranked 
player on your list.  He goes for $5. 

To recalculate the dollar value of the remaining players we would figure out 
how many dollars remain ($3,120 less the $90 spent), how many players are 
yet to be selected (because we have to allocate at least $1 to each), and how 
many points are remaining in the top 168 undrafted players.  Right? 

STOP.  All of that is correct except the last part.   

Because a player outside of the top 168 was taken, we’re no longer looking for 
the remaining points in the top 168.  We’re now looking for the 
remaining points in the top 167!  Our player pool has just become the top 
167 hitters plus the 175th best hitter. 

This might sound like a small detail, but this isn’t going to happen with just 
one player.  We don’t all agree on the top 168 players.  Especially the bottom of 
that list.  Opinions differ.  I’m willing to bet you’ll see 5, 10, or maybe even 15 
players taken that are outside of your list.  That adds up! 

We need to track how many players outside of our “draftable” pool are 
selected. 

EXCEL FUNCTIONS AND CONCEPTS IN PART 9 

AND 

The AND formula checks to see if each of a series of conditions you specify 
are met.  If ALL of the conditions are met, the formula will return an answer 
of “TRUE”.  If even one of the conditions is not met, the formula will return 
an answer of “FALSE”. 

Recall from Part 8 that we added a column for “USEFUL PTS” to our “Hitter 
Ranks” and “Pitcher Ranks” tabs.  This was used to calculate the total points 
over replacement level for draftable players.  Previously we set our formula 
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for “USEFUL PTS” to determine if a player was in the top 168 hitters or top 
108 pitchers.   

We now need to add another condition to determine “USEFUL PTS”, but this 
time only if the player has not been kept or drafted.  Only available players 
should go into our “USEFUL PTS” amount.   

To test for more than one condition, we can use the AND formula.  This can 
accept multiple inputs.  Each input must be a logical test.   

AND ( Logical_test1, Logical_test2, … ) 

1. Logical_test1 – This must be a statement that can be determined to 
be true or false.  An example might be “Is this player ranked in the top 
168 hitters?”.   

2. Logical_test2 – This must be a separate statement that can be 
determined to be true or false.  An example might be “Does this 
player have a keeper amount associated with him?”   

3. The “…” in the formula represents the fact that you can continue to 
add additional logical tests to the formula.  Separate each test by a 
comma.   

NESTING FORMULAS 

Excel allows you to have one formula act as an input in another formula.  Our 
“USEFULSGP” column added in Parts 8 and 9 utilized the “IF” function, 
which required a logical test as the first input.  This test would return a value 
of “TRUE” if the test was met and “FALSE” if the condition was not. 

You’ll note from above that the “AND” function returns a value of “TRUE” if 
all the conditions are met and “FALSE” if they are not.  So the “AND” 
function can be used as an input as the logical test in the “IF” function.  So 
instead of having one logical test, like this: 

= IF ( Logical_Test1 , Answer_if_True ,  Answer_if_False ) 

We can “nest” the “AND” function into that same formula like this: 
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= IF ( AND ( Logical_Test1 , Logical_Test2 ) , Answer_if_True , 
Answer_if_False ) 

COUNT 

The COUNT formula counts the number of cells in a given range that contain 
numeric values.  It’s fairly straight forward to use: 

= COUNT(RANGE) 

For example, the formula =COUNT(Z2:Z6) in the image below would return 
a value of 4 because only four of the five player had been drafted in this 
scenario.   

 

COUNTIFS 

The COUNTIFS formula is similar to COUNT but it only counts the numeric 
values if other conditions are met.  We are going to use this formula to 
determine how many players below replacement level have been drafted.  I’ll 
explain more about why in a bit, but we will use COUNTIFS to count any 
player that: 

• Was drafted (or has an actual drafted dollar value assigned to them) 

• And their RANK is below 168 (in my example of a league with 168 
hitters) 

The inputs into the COUNTIFS formula are: 

= COUNTIFS (Criteria_range1, Criteria1, Criteria_range2, Criteria2, 
…) 
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1. Criteria_range1 – Range of cells you want to evaluate to see if they 
meet the terms specified in Criteria1 

2. Criteria1 – A logical condition to apply against Criteria_range1 (e.g. 
“>0”) 

3. Criteria_range2 – Range of cells you want to evaluate to see if they 
meet the terms specified in Criteria2 

4. Criteria2 - A logical condition to apply against Criteria_range2 (e.g. 
“>0”) 

5. The “…”signifies that you can continue to add more sets of 
“Criteria_range” and “Criteria” pairs. 

Excel will count the number of times ALL of the criteria are met.  For the 
example mentioned above we will be asking to count players with a 
drafted/actual dollar value AND players whose rank is below 168.  Players in 
our spreadsheet will only be counted if they meet BOTH of those criteria. 

STEP-BY-STEP INSTRUCTIONS 

Step Description 

1.  Go to the “Hitter Ranks” tab of your spreadsheet.  Click your mouse to select the 
first open cell to the right of the “$VALUE” column (cell AB1 in my example).  
Type “$ACTUAL” here as the column header. 

 
This new column will be used to enter in keeper values or the actual auction 
price a player goes for during the draft. 
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Step Description 

2.  Click your mouse to select the first open cell to the right of the “$ACTUAL” 
column you just created (cell AC1 in my example).  Type “REMAIN PTS OVER 
REPL” here as the column header. 

 
The “REMAIN PTS OVER REPL” column will be used to determine a running 
total of the useful hitter points remaining to be drafted (e.g. players in the top 
168 hitters that are still available).  As soon as a player is drafted, the player’s 
points will be removed from the pool of remaining points. This will 
immediately update the dollar value of the remaining points. 

3.  Click your mouse to select the first open cell to the right of the “REMAIN PTS 
OVER REPL” column you just created (cell AD1 in my example).  Type 
“$INFLATE” here as the column header. 

 
The “$INFLATE” column will be used to calculate the updated price for each 
player and will immediately include the effect of any inflation. 

4.  Repeat steps 1 through 3 on the “Pitcher Ranks” tab of your spreadsheet.  
Here’s where the new columns were located in my example spreadsheet: 

• $ACTUAL – Column Y 

• REMAIN PTS OVER REPL – Column Z 

• $INFLATE – Column AA 

 
5.  Return to the “Scoring Settings” tab of your spreadsheet.  We will now add 11 

new calculated fields to this tab.  Many of them mirror the calculations we 
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already created for the normal dollar value calculations, but we must now add 
new formulas to determine inflated prices. 

Enter the following descriptions in cells M2 through M16 (see image below): 

 

 
6.  To format these: 

• Select the “Total League Budget” dollar amount in cell K3 and then 
double-click the Format Painter (on the Home tab of the ribbon).  Then 
click once on cells N2, N3, and N15 (the cells next to “Actual Value of 
Drafted Hitters”, “Actual Value of Drafted Pitchers”, and “Remaining 
Dollars to Allocate to Points”).  Hit the ESC key to exit Format Painter. 

• Select the “Total Hitters Drafted” number in cell K8 and then double-
click the Format Painter.  Then click once on cells N5, N6, N8, N9, N11, 
N12, and N13 (this should just leave N16, “Remaining Dollar Value Per 
Point”, unformatted).  Hit the ESC key to exit Format Painter. 

• Finally, select the “Dollar Value Per Point” amount in cell K16 and click 
once on the Format Painter.  Then click once on cell N16.  
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7.  We will now start to calculate some of these fields based on information on the 
“Hitter Ranks” and “Pitcher Ranks” tabs. 

The “Actual Value of Drafted Hitters” field will be used to calculate everything 
spent (through keepers or during the draft) on hitters.  We need this to 
determine how much league money is left to spend. 

To calculate the “Actual Value of Drafted Hitters”, enter the following formula 
in cell N2: 

=SUM(MYRANKS_H[$ACTUAL]) 

Test that this formula is working properly by entering $5 on the “Hitter 
Ranks” tab for one of the highest ranked players (e.g. Mike Trout). 

 
When you return to the “Scoring Settings” tab you should see this $5 flowing 
in to the “Actual Value of Drafted Hitters”. 

 
8.  Repeat step 7 for the “Actual Value of Drafted Pitchers” field.  The formula to 

enter into cell N3 is: 

=SUM(MYRANKS_P[$ACTUAL]) 

Test that this formula is working properly by entering $10 on the “Pitcher 
Ranks” tab for one of the highest ranked pitchers (e.g. Clayton Kershaw). 

 



How to Rank and Value Fantasy Baseball Players for Points Leagues   

Page | 144 
 

Step Description 

9.  As I alluded to in the introduction to this section, we need to use “Hitters 
Below Repl. Level Drafted” to count the number of players chosen during the 
draft that fall below your definition of Replacement Level. 

 
To calculate this, click on cell N5 and then click the “Insert Function” bar on 
the Excel toolbar. 

 
10.  Type “COUNTIFS” in the search box and click “Go”.  Locate “COUNTIFS” in 

the list of functions and hit “OK”. 
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11.  To identify players selected that are below replacement level we need to test 

two criteria: 

• Do they have a “$ACTUAL” value that is greater than zero (meaning 
someone bid on and drafted the player) 

• And is the player’s rank greater than the number of hitters/pitchers that 
should be drafted (meaning they are outside the top 168 hitters or top 
108 pitchers). 

To put this first bullet into our formula enter the following into the 
“Criteria_range1” field.  We are telling Excel we want to evaluate the 
“$ACTUAL” column in the “Hitter Ranks” tab (our “MYRANKS_H” table) 

MYRANKS_H[$ACTUAL] 

Then enter ">0" in the “Criteria1” field.  Here we are telling Excel to evaluate 
and count the number of players with a “$ACTUAL” greater than zero. 
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12.  To test the first part of our equation, hit “OK” to save the formula with only 

“Criteria_range1” and “Criteria1” filled out.   

Because we still have a $5 entry for one of the hitters, you should see a 1 in 
your “Hitters Below Replacement Level Drafted” field. 

 

13.  To add our second set of criteria, click once on cell N5 and hit the  

“Insert Function” button again.   
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Click your mouse in the “Criteria1” field (containing the “>0”.  This should 
make “Criteria_range2” appear. 

 
 

14.  We will use “Criteria_range2” to determine if the hitter’s rank falls outside the 
pool of draftable players (below replacement level). 

Type the following into the “Criteria_range2” box: 

MYRANKS_H[RANK] 

Then type the following formula into the “Criteria2” box: 

">"&TOTAL_HITTERS_DRAFTED 

This last formula is a little odd.  We are trying to pull in the number of hitters 
drafted according to our league settings (cell K8 on the “Scoring Settings” tab 
in my example).  Because we are referencing this cell and not typing in the 
number “168”, we need to put “TOTAL_HITTERS_DRAFTED” outside the 
quotation marks.   

The ampersand (&) appends the “>” and TOTAL_HITTERS_DRAFTED 
together into one string.  You should see this by looking at Excel’s preview of 
the formula to the right.  Excel is interpreting this as “>168”. 
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15.  Click “OK” to save the COUNTIFS formula.  Because we have not entered 

dollar values for any players below replacement level, you should see a zero 
now. 

 
To test that this is working properly, go to the “Hitter Ranks” tab and enter $1 
in for a player ranked outside your draftable hitters (e.g. the 175th ranked 
hitter).  Then come back to the “Scoring Settings” tab and verify that this 
player is being counted. 

 

16.  We’ll now to steps 9 through 15 on the “Pitcher Ranks” tab, but we can take a 
pretty quick shortcut.  Instead of building the formula from scratch, just copy 
the formula from cell N5 and paste it into N6 and make the following 
adjustments: 

=COUNTIFS(MYRANKS_P[$ACTUAL],">0",MYRANKS_P[RANK], 
">"&TOTAL_PITCHERS_DRAFTED) 

If you want to see what this would look like in the formula wizard: 

 
Perform a similar test to the one we did in step 15.  Add a $1 value to a player 
outside the top draftable pitchers (top 108 for my example file).  You should also 
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notice that the values of drafted hitters and pitchers is also changing to reflect 
these $1 players that have been “drafted”. 

 
17.  We will be using the “Hitters Below Repl. Level Drafted” and “Pitchers Below 

Repl. Level Drafted” in later formulas so we should name the cells. 

Click on the shaded “Hitters Below Repl. Level Drafted” field (cell N5).   

 
Then type “HITTERS_BELOW_REPL_DRAFTED” in the Name Box and hit 
Enter. 

 
Then click on the shaded “Pitchers Below Repl. Level Drafted” field (cell N6).  
Then type “PITCHERS_BELOW_REPL_DRAFTED” in the Name Box and hit 
Enter. 

 
18.  If it’s not still fresh in your mind, now may be a good time to reread the “Below 

Replacement Level Players” sub-section at the beginning of this chapter.   

We will now enter a complicated formula in the “REMAIN PTS OVER REPL” 
column of the “Hitter Ranks” tab.  Copy and paste the following into the first 
cell beneath the “REMAIN PTS OVER REPL” header. 
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=IF(AND([@RANK]<=(TOTAL_HITTERS_DRAFTED-
HITTERS_BELOW_REPL_DRAFTED),[@[$ACTUAL]]=""),[@[POI

NTS OVER REPL]],0) 

 
19.  Let’s break this down into more digestible parts so we can understand what 

this is doing. 

First the AND formula: 

AND([@RANK]<=(TOTAL_HITTERS_DRAFTED-
HITTERS_BELOW_REPL_DRAFTED),[@[$ACTUAL]]="") 

Recall that the AND formula checks all the conditions listed between the 
parentheses and makes sure they are true.  If all the conditions are met it gives 
a response of “TRUE”.  Here are the two conditions I have in the AND 
formula: 

• ([@RANK]<=(TOTAL_HITTERS_DRAFTED-
HITTERS_BELOW_REPL_DRAFTED) – this is checking to see if 
the players rank is less than or equal to the hitters drafted (e.g. 168) 
minus the hitters selected below replacement level.  This is because if a 
player below replacement level is drafted we no longer assume the top 
168 players are drafted.  We now care about the top 167 and the one 
below replacement level player. 

• [@[$ACTUAL]]="" – This is simply a check to see if the player has 
been drafted/auctioned off (if the $ACTUAL column is blank for the 
player, “” means blank). 

Now step outside the and formula to the IF formula: 

=IF(AND(Formula),[@[POINTS OVER REPL]],0) 

In plain English, this is saying, “If the AND formula is true then give me the 
players POINTS OVER REPL.  If the AND formula is false then give me zero”. 
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20.  To test that this is working, scroll down in the “Hitter Ranks” tab so that you 
get to the area where your replacement level players are specified.  Start 
entering $1 for several of the players that fall below replacement level (e.g. 
below 168). 

You should see the REMAIN PTS OVER REPL start to zero out for players just 
above the replacement level threshold.  Watch the area in the red circle as you 
add more $1 players.   

 
21.  Repeat steps 18 and 20 on the “Pitcher Ranks” tab.  The formula to paste will 

be the same as the “Hitter Ranks” formula with the following edits: 

Copy and paste the following into the first cell beneath the “REMAIN PTS 
OVER REPL” header. 

=IF(AND([@RANK]<=(TOTAL_PITCHERS_DRAFTED-
PITCHERS_BELOW_REPL_DRAFTED),[@[$ACTUAL]]=""),[@[PO

INTS OVER REPL]],0) 

22.  Our next task is to figure out how many players have been drafted.  Return to 
the “Scoring Settings” tab.  Click on the “Remaining Hitters to be Drafted” 
shaded field (cell N8 in my example file). 
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This will be our TOTAL_HITTERS_DRAFTED cell (K8 above) minus the 
count of all players that were drafted (or any player with a value in the 
$ACTUAL column of the “Hitter Ranks” tab. 

To do this, enter the following formula in the cell: 

=TOTAL_HITTERS_DRAFTED-COUNT(MYRANKS_H[$ACTUAL]) 

Make sure the answer the formula returns makes sense.  For example, I 
entered a dollar value for the best player and four players below replacement 
level previously, so my answer of 163 is correct. 

 
23.  Copy the formula from above and paste it into the “Remaining Pitchers to be 

Drafted” shaded cell.  Change the formula to be: 

=TOTAL_PITCHERS_DRAFTED-
COUNT(MYRANKS_P[$ACTUAL]) 

Then verify the answer from the formula seems correct. 
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24.  Next we will determine the “Remaining Draftable Hitter Points”.  Click on the 

shaded cell next to this label (cell N11 in my file).  Enter the following formula 
into this cell: 

=SUM(MYRANKS_H[REMAIN PTS OVER REPL]) 

This should be a slightly lower number than the “Draftable Hitter Points” cell 
to the left.  As more and more players are drafted this “Remaining Draftable 
Hitter Points” amount should approach zero. 

 
25.  Copy the formula from step 24 above and paste it into the shaded cell next to 

“Remaining Draftable Pitcher Points”.  Then make this small change to the 
formula: 

=SUM(MYRANKS_P[REMAIN PTS OVER REPL]) 

 

26.  Enter the following formula in the “Total Remaining Draftable Points” shaded 
cell, in order to add the “Remaining Draftable Hitter Points” and “Remaining 
Draftable Pitcher Points” together (adjust for your spreadsheet if cells are not 
exactly where my example file’s are): 

=N11+N12 
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27.  The next thing we’ll be doing is to determine the remaining dollars that will be 

allocated to points.  Remember that some of our remaining dollars will be 
spent on the $1 minimum price for each slot yet to be drafted. 

The amount of money that will be allocated to points is our league budget: 

• Less what has been spent on hitters  

• Less what has been spent on pitchers  

• Less the number of hitters to still be drafted ($1 per) 

• Less the number of pitchers still to be drafted ($1 per) 

I suggest naming each of our cells that correspond to the bullets above.  To do 
this, click in the shaded cell for “Dollar Value of Drafted Hitters” (N2) and 
enter the name “VALUE_OF_DRAFTED_HITTERS” in the Name Box.  Then 
hit Enter. 

 
28.  Repeat the naming process for each of these cells: 

• “Actual Value of Drafted Pitchers” (N3) – name this 
“VALUE_OF_DRAFTED_PITCHERS” 

• “Remaining Hitters to be Drafted” (N8) – name this 
“REMAINING_HITTERS_TO_DRAFT” 
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• “Remaining Pitchers to be Drafted” (N9) – name this 
“REMAINING_PITCHERS_TO_DRAFT” 

29.  Then in the shaded cell next to “Remaining Dollars to Allocate to Points” paste 
the following formula: 

=LEAGUE_BUDGET-VALUE_OF_DRAFTED_HITTERS-
VALUE_OF_DRAFTED_PITCHERS-

REMAINING_HITTERS_TO_DRAFT-
REMAINING_PITCHERS_TO_DRAFT 

30.  Now it's time to calculate the inflation adjusted dollar value of each point over 
replacement level. To calculate this, enter the following formula in cell N16 and 
hit Enter: 

=N15/N13 

 
Because my calculation results in so many decimals, I formatted this cell to have 
a dollar sign and then I increased the decimals several places. 

31.  We will be using the value we just calculated on the “Hitter Ranks” and “Pitcher 
Ranks” tabs to calculate an inflation-adjusted value for each player.  I suggest 
naming the cell so it will be easier to reuse on these other tabs. 

Click on the “Remaining Dollar Value Per Point” shaded cell and then enter the 
name “REMAINING_DOLLAR_VALUE_PER_POINT”.  Hit Enter to save the 
name. 

 

32.  Now go to the “Hitter Ranks” tab.  In the first cell under the $INFLATE column 
header, enter the following formula: 
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=[@[POINTS OVER 
REPL]]*REMAINING_DOLLAR_VALUE_PER_POINT+1 

This formula will calculate takes each players inflation-adjusted price given the 
amount of money the league has remaining to spend in the draft and the 
projected points to be scored by the remaining players. 

33.  Things will probably seem like they’re working at this point, but if you take a 
closer look there’s still one thing we should change. 

The formula for step 32 is also calculating a new price for players that have 
already been drafted. 

 
We should add a condition so that if a player has an $ACTUAL price that no 
inflation adjusted price will calculate.  To do this, revise the formula from step 
32 to be: 

=IF([@[$ACTUAL]]="",[@[POINTS OVER 
REPL]]*REMAINING_DOLLAR_VALUE_PER_POINT+1,0) 

 
34.  Copy the formula above and paste it into the first cell of the $INFLATE 

column on the “Pitcher Ranks” tab. 
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35.  You did it!   

 

WRAP UP 

You now have dollar value calculations that will update immediately as you 
enter in drafted players.  If teams in your league are overspending, you can 
instantly see the effect this will have on prices the remainder of the draft.  
You’ll be able to make decisions that help you to squeeze every drop of value 
out of the player pool and onto your roster! 

DO YOU HAVE ANY QUESTIONS? 

Do you have questions about Part 9?  Or want to see what others have asked?  
Check here. 

EXAMPLE EXCEL FILE 

Download the example spreadsheet illustrating the work done in this part 
here.  Or you can download all spreadsheets for the entire book here.  

FREQUENTLY ASKED QUESTIONS 
I DON’T AGREE WITH ALL OF THE PROJECTIONS INCLUDED IN THE FILE I 
DOWNLOADED.  CAN I EDIT THEM? 

Yes!  Simply go the hitter or pitcher projections tabs and type over the 
projected statistics you don’t like.   

 

For instance, in my example file Bryce Harper is projected for only 557 plate 
appearances and 23 home runs, surely due to his injury history.  If you feel 
very strongly that he’ll stay healthy this year and get to 650 plate appearances 
and 29 home runs, just locate him on the “Steamer Hitters” tab and type in the 
full projection you wish to have. 

http://www.smartfantasybaseball.com/how-to-rank-and-value-players-in-a-points-league-part-9/%23comment-976
http://www.smartfantasybaseball.com/points9
http://www.smartfantasybaseball.com/jzv0
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They great thing about this spreadsheet we have built is that everything is 
linked.  As soon as you type in Harper’s new projection you will see everyone’s 
dollar value update!  You’ll get a new dollar value for Harper and it will change 
everyone else’s value slightly. 

This is also extremely valuable for player injuries that happen during the 
preseason.   

If you really enjoy the process of developing your own projections, I have 
guidance on how you can create your own here. 

I PLAY IN MORE THAN ONE POINTS LEAGUE AND THEY’RE ALL SLIGHTLY 
DIFFERENT.  HOW CAN I USE THIS FILE FOR ALL MY LEAGUES? 

I would suggest working your way through the entire book with one league in 
mind and save the file.  When you’re confident you have that one correct and 
finished perform a “Save As” in Excel.   

Name this new file “League 2 Points League Rankings” or something to clearly 
identify it’s for the next league.  Then you will only need to make these 
adjustments (you don’t have to start from scratch for each league): 

1. Make the necessary adjustments on the “Scoring Settings” tab.  Revisit the 
step-by-step instructions in Part 2 if you need to add new scoring 
categories.   

Then be sure to make the related adjustments in the “PROJ PTS” columns 
on the “Hitter Ranks” and “Pitcher Ranks” tabs.   Review the instruction in 
Part 5 for a reminder on this. 

2. Update the Team and League settings on the “Scoring Settings” tab. 

http://www.smartfantasybaseball.com/projecting-x-podhorzer-how-to-create-your-own-fantasy-baseball-projections/
http://www.smartfantasybaseball.com/projecting-x-podhorzer-how-to-create-your-own-fantasy-baseball-projections/
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3. Re-determine replacement level for this new 
league.  I would delete the point values from 
the Replacement Level table, clear any 
shading you did to identify and start all over 
with this exercise.  I find it very confusing to 
only make minor adjustments.  It’s easier for 
me to just start over. 

I HAVE A MAC AND USE EXCEL FOR MAC.  CAN 
I USE THIS BOOK? 

Yes and no.  It is my understanding that some of the newer versions of Excel 
for Mac do use the Table and Structured Reference formula terminology that I 
use in this book.  For those newer versions I think this book will work as 
expected. 

Unfortunately, this is a somewhat recent development.  Some older versions of 
Excel for Mac are very different than the Windows version and do not have all 
the same functionality.   

If you are an experienced Excel user, I think you will be able to work around 
the formula differences.  If you’re not, these instructions might not translate 
well to Excel for Mac.  I don’t know why the two programs are so different, but 
they are.   

The most notable difference is the Named Table function, which is utilized in 
many of the VLOOKUP formulas in this book. 

You can work around this by tweaking the VLOOKUP formulas.  An example 
formula given in this book might be: 

=VLOOKUP([@PLAYERID],PLAYERIDMAP,COLUMN(PLAYERIDMA
P[LASTNAME]),FALSE) 

Where [@PLAYERID] is referencing the “PLAYERID” column in a named 
table and where “LASTNAME” is a column in the “PLAYERIDMAP” named 
table. 

In Excel for Mac, you would need to use a formula like this: 
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=VLOOKUP(A2,PLAYERIDMAP,4,FALSE) 

Where cell “A2” is the “PLAYERID” to look up and where “4” is the fourth 
column in the PLAYERIDMAP.  Depending on your familiarity with Excel, you 
might even prefer this formula. 


	From The Author
	Objectives
	Overview
	Why I Wrote This Book
	Microsoft Excel
	Download Example Excel Files
	The History Of This Book
	If You Have Questions
	Part 1 – Download Projection Data and Player ID Map
	Introduction
	Where to Get Projections
	Use Whatever Projection System You Prefer
	What is a Player ID?
	Step-by-Step Instructions
	Wrap Up
	Do You Have Any Questions?
	Example Excel File

	Part 2 – Set Up League Scoring Settings
	Introduction
	Excel Functions and Formulas in this Part
	Named Cells (Or Named Ranges)
	Using Cell Shading to Indicate Meaning

	Adjust for Your League’s Scoring Settings
	Step-By-Step Instructions
	Wrap Up
	Do You Have Any Questions?
	Example Excel File

	Part 3 – VLOOKUP, Excel Tables, and Structured References
	Introduction
	Excel Functions and Formulas In This Part
	VLOOKUP
	Tables (Named Ranges, Structured References)
	COLUMN
	IFERROR

	Step-By-Step Instructions
	Wrap Up
	Do You Have Any Questions?
	Example Excel File

	Part 4 – Pitcher Rankings
	Introduction
	Excel Functions and Formulas In This Part
	Step-By-Step Instructions
	Wrap Up
	Do You Have Any Questions?
	Example Excel File

	Part 5 – Calculating Projected Points
	Introduction
	Excel Functions and Formulas in This Part
	Step-By-Step Instructions
	Wrap Up
	Do You Have Any Questions?
	Example Excel File

	Part 6 – Replacement Level and Position Scarcity
	Introduction
	Accounting for Replacement Level
	Using Points League Settings
	Positional Scarcity Adjustments
	Excel Functions and Formulas in this Post
	Step-by-Step Instructions
	Wrap Up
	Do You Have Any Questions?
	Example Excel File

	Part 7 – Dollar Value Calculation Settings
	Introduction
	Excel Functions and Concepts in this Post
	"COMPARTMENTALIZING" COMPLEX EQUATIONS
	Using Cell Shading to Indicate Meaning
	Named Cells (or Named Ranges)

	Step-by-Step Instructions
	Wrap Up
	Do You Have Any Questions?
	Example Excel File

	Part 8 – Converting Points Into Dollar Values
	Introduction
	Calculating Values
	Excel Functions and Concepts in this Part
	RANK OR RANK.EQ
	IF
	SUM

	Step-By-Step Instructions
	Wrap Up
	Disclaimer
	Do You Have Any Questions?
	Example Excel File

	Part 9 – Incorporating In-Draft and Keeper League Inflation
	Introduction
	Recalculating Dollars Per Point
	Below Replacement Level Players
	Excel functions and Concepts In part 9
	AND
	Nesting Formulas
	COUNT
	COUNTIFS

	Step-by-Step Instructions
	Wrap Up
	Do You Have Any Questions?
	Example Excel File

	Frequently Asked Questions
	I Don’t Agree With All of the Projections Included in the File I Downloaded.  Can I edit Them?
	I Play in More Than One Points League and They’re All Slightly Different.  How Can I Use This File For All My Leagues?
	I have a Mac and use Excel for Mac.  Can I use this book?


